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Introduction 

 

Read this Instruction Manual thoroughly before using the product. 

Thank you for purchasing this product.  

This manual describes the installation, operation, usage cautions and accessories for this product. 
Read this manual thoroughly before using the product and operate the product in accordance with the 
instructions in this manual. 

Also, keep this manual for future reference.  

 

 

 

 

 

 

 

 

 

 

Notices 

 All rights are reserved, including those to reproduce this publication or parts thereof in any form without 
permission in writing from Shimadzu Corporation. 

 Information in this publication is subject to change without notice and does not represent a commitment on 
the part of the vendor. 

 Any errors or omissions which may have occurred in this publication despite the utmost care taken in its 
production will be corrected as soon as possible, although not necessarily immediately after detection. 

 Shimadzu Corporation is not responsible for errors or injuries resulting from following the instructions in this 
document. 

 Replacement parts for this product will be available for a period of seven (7) years after the product is 
discontinued. Thereafter, such parts may cease to be available. Note, however, that the availability of parts 
not manufactured by Shimadzu shall be determined by the relevant manufacturers. 

 Microsoft and Windows are registered trademarks of Microsoft Corporation in the United States and other 
countries. All brand names and product names are trademarks or registered trademarks of their 

respective companies. The TM and ® symbols are omitted in this manual. 

 This product is provided "as is", and Shimadzu Corporation makes no warranty of any kind with respect to 
this product or information contained therein. Shimadzu Corporation does not warrant the accuracy or 
fitness for a particular purpose. In no event will Shimadzu Corporation be liable for any damages whether 
direct, indirect, special, incidental, consequential or punitive (including but not limited to lost profits) arising 
out of or in connection with the use of this product. You have sole responsibility for any consequences from 
using this product. 

 This product is for research purposes only. Not for diagnostic use. 

 © 2017-2023 Shimadzu Corporation. All rights reserved. 
Original version is approved in English. 
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Software License Agreement 

PLEASE READ THIS AGREEMENT CAREFULLY BEFORE USING THE SOFTWARE.  

SHIMADZU Corporation (“SMZ”) is willing to license the SMZ software provided herein, together with accompanying 

documentation (collectively “SOFTWARE”) to you only upon the condition that you accept all of the terms and 

condition contained in this License Agreement. By using the SOFTWARE, you agree to be bound by the terms of 

this Agreement. If you do not agree to all these terms of this Agreement, promptly return the unused SOFTWARE 

to the party (either SMZ or its reseller) from whom you acquired it to receive a refund of the amount you paid. 

 

1. LICENSE. 

SMZ grants you a non-exclusive and nontransferable license to use the SOFTWARE subject to the following 

terms and conditions. 

2. LIMITATION OF USE. 

Except as specifically authorized by SMZ, you may NOT: 

a. Use the SOFTWARE, or permit the SOFTWARE to be used, on more than one computer at any one time. 

b. Copy the SOFTWARE except one (1) archival copy of the SOFTWARE. 

c. Modify, reverse engineer, decompile, disassemble, or create derivative works based upon the SOFTWARE. 

d. Transfer, rent, lease or grant any rights in the SOFTWARE in any form to anyone else. 

3. TITLE AND OWNERSHIP. 

This license is not for sale and it may not be assigned or sublicensed to anyone else. Title and all associated 

intellectual property rights to the SOFTWARE shall remain in SMZ and/or its licensor. 

4. UPGRADES. 

You are entitled to receive all official software upgrades for the SOFTWARE that SMZ will release as deemed 

necessary by SMZ. An upgrade means certain supplemental program modules and/or information for bug fixing and/or 

updates to the defects and/or failures of the SOFTWARE that are acknowledged or confirmed by SMZ. An upgrade 

excludes hardware, network, consulting services, third party products, operation and general computer system 

maintenance. All supplemental program module for upgrades and enhancements furnished to you shall be deemed to 

be part of the SOFTWARE and subject to the terms and conditions set forth in this Agreement. 

5. LIMITED WARRANTY. 

SMZ warrants that for a period of one (1) year from the date of purchase, as evidenced by a copy of the receipt, 

the media on which SOFTWARE is furnished will be free of defects in materials and workmanship under normal 

use.  

Except for the foregoing, SOFTWARE is provided AS IS. Your exclusive remedy and the entire liability of SMZ 

and its suppliers under this limited warranty will be, at SMZ’s option, repair, replacement, or refund of the 

Software if reported (or, upon request, returned) to the party supplying the SOFTWARE to you. In no event does 

SMZ warrant that the Software is error free or that you will be able to operate the SOFTWARE without problems 

or interruptions. 

EXCEPT AS SPECIFIED IN THIS WARRANTY, ALL EXPRESS OR IMPLIED CONDITIONS, 

REPRESENTATIONS, AND WARRANTIES INCLUDING, WITHOUT LIMITATION, ANY IMPLIED WARRANTY 

OF MERCHANTABILITY, FITNESS FOR A PARTICULAR PURPOSE, NONINFRINGEMENT, ARISING FROM A 

COURSE OF DEALING, USAGE, OR TRADE PRACTICE, ARE HEREBY EXCLUDED TO THE EXTENT 

ALLOWED BY APPLICABLE LAW.  

6. LIMITATION OF LIABILITY. 

IN NO EVENT WILL SMZ BE LIABLE FOR ANY LOST REVENUE, PROFIT OR DATA, OR FOR SPECIAL, 

INDIRECT, CONSEQUENTIAL, INCIDENTAL OR PUNITIVE DAMAGES, HOWEVER CAUSED REGARDLESS OF 

THE THEORY OF LIABILITY, ARISING OUT OF OR RELATED TO THE USE OF OR INABILITY TO USE 

SOFTWARE, EVEN IF SMZ HAS BEEN ADVISED OF THE POSSIBILITY OF SUCH DAMAGE.  IN NO EVENT WILL 

SMZ’S LIABILITY TO YOU, WHETHER IN CONTRACT, TORT (INCLUDING NEGLIGENCE), OR OTHERWISE, 

EXCEED THE AMOUNT YOU PAID FOR SOFTWARE. 
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7. TERMINATION. 

This License is effective until terminated. You may terminate this License at any time by destroying all copies of 

SOFTWARE including any documentation. This License will terminate immediately without notice from SMZ if you 

fail to comply with any provision of this License. Upon termination, you must destroy all copies of SOFTWARE. 

8. GENERAL 

a. This Agreement is the entire agreement. If any provision of this agreement is held invalid, the remainder of 

this agreement shall continue in full force and effect. 

b. This Agreement shall be construed and governed in accordance with the laws of Japan, excluding its conflict of 

law rules. 

c. The exclusive jurisdiction for any disputes arising out of or in connection with this Agreement shall be Kyoto District 

Court of Japan. 

d. The invalidity or unenforceability of any provision of this Agreement shall not affect the validity or enforceability of any 

other provision. 
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About This Manual 

Throughout the text in this manual, warnings and other information essential when using this product, 
such as cautionary or prohibited items, appear classified as per the following: 

 

 

Mark Description 

 

Indicates a potentially hazardous situation which, if not avoided, 
could result in serious injury or possibly death. 

 

Indicates a potentially hazardous situation which, if not avoided, may 
result in minor to moderate injury or equipment damage. 

 

Emphasizes additional information that is provided to ensure the 
proper use of this product. 

 

Provides useful information about operation of this system. Please 
read the description when required. 

 
Indicates reference sections and pages. 

 

 

 

 

 

 

 

 

 

 

 

 

 

For customers using the DVD distributed version: 

This is a DVD disk. Do not play this on an audio CD player, as the high volume may damage your 
hearing or the audio speakers. 
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Warranty 

 

Shimadzu Corporation provides the following warranty for this product. 

 

 

1. Period: Please contact your Shimadzu representative for information about the period of this 
warranty.  

2. Description: If a product/part failure occurs for reasons attributable to Shimadzu during the 
warranty period, Shimadzu will repair or replace the product/part free of charge. 
However, in the case of products which are usually available on the market only for 
a short time, such as personal computers and their peripherals/parts, Shimadzu may 
not be able to provide identical replacement products. 

3. Limitation of 
Liability: 

(1) In no event will Shimadzu be liable for any lost revenue, profit or data, or for 
special, indirect, consequential, incidental or punitive damages, however caused 
regardless of the theory of liability, arising out of or related to the use of or inability 
to use the product, even if Shimadzu has been advised of the possibility of such 
damage. 

(2) In no event will Shimadzu's liability to you, whether in contract, tort (including 
negligence), or otherwise, exceed the amount you paid for the product. 

4. Exceptions: Failures caused by the following are excluded from the warranty, even if they occur 
during the warranty period.  

1) Improper product handling 

2) Repairs or modifications performed by parties other than Shimadzu or Shimadzu 
designated companies  

3) Product use in combination with hardware or software other than that designated 
by Shimadzu  

4) Computer viruses leading to device failures and damage to data and software, 
including the product's basic software  

5) Power failures, including power outages and sudden voltage drops, leading to 
device failures and damage to data and software, including the product's basic 
software 

6) Turning OFF the product without following the proper shutdown procedure 
leading to device failures and damage to data and software, including the 
product's basic software 

7) Reasons unrelated to the product itself 

8) Product use in harsh environments, such as those subject to high temperatures 
or humidity levels, corrosive gases, or strong vibrations 

9) Fires, earthquakes, or any other act of nature, contamination by radioactive or 
hazardous substances, or any other force majeure event, including wars, riots, 
and crimes  

10) Product movement or transportation after installation  

11) Consumable items 

Note: Recording media such as floppy disks, CD-ROMs and DVD-ROMs are 
considered consumable items. 

⚫ If there is a document such as a warranty provided with the product, or there is a separate contract agreed upon 
that includes warranty conditions, the provisions of those documents shall apply. 
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Preface 

 

Preface 
 
About this manual 

 
This manual contains detailed instructions on installing, configuring and using the LabSolutions 
Insight software. 
 
This User Guide assumes that the reader has a reasonable knowledge of the Windows operating 
system, and how to use the standard Windows features, such as menus, checkboxes, drop-down 
lists and scroll bars. Please refer to your Windows support material (Help or the manual) for 
information on such matters. 

 

About LabSolutions Insight 
 

LabSolutions Insight (Insight) is a piece of software intended for displaying and manipulating 
multi-component mass spectrometry data. The software aims to flag target compounds that are 
outside of user-predefined tolerances and filter out unwanted data so that the observer can focus on 
important data.  

The flags enable the operator to quickly assess the quality of the results and take any corrective 
action that may be possible, such as, but not limited to, re-integration or re-identification of a 
compound’s peak and rejection of an outlying standard sample response. 

The reporting limits enable the operator to produce reports that contain only those compounds that 
are within the specified limits, which is common in applications such as water quality analysis where 
a large number of compounds are screened but usually only a few may be significant. 

The QC Chart shows the deviation of RT, Area and so on between each sample. 

The analysis results and the method parameters used at each step of the workflow can be saved in 
a single file (the processing file).  Using this file, it is possible to switch between various sets of 
analysis parameters to compare analysis results. 

Insight handles GCMSsolution data (GCMS-QP series and GCMS-TQ series) and LabSolutions 
LCMS (LC-MS/MS 2020, 2050, 8030, 8040, 8045, 8050, 8060(NX), 9030, 9050) data. 

Users are expected to analyse their samples using the GCMSsolution or LabSolutions workflow and 
use the Insight browser software for results review and re-processing of those compounds that have 
been automatically flagged. Later, a report may be produced from the Insight browser that outputs 
only those compounds that are within the reporting limits set. 
 
When LabSolutions Insight is installed 4 icons will appear on the desktop and start-up menu: 

 

 

Application Configuration 

 

Report Configuration 

 

LabSolutions Insight LCMS 

ZStanius
Highlight

ZStanius
Typewriter
1.6.2
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LabSolutions Insight GCMS 

 

 
Each application will be explained in detail in the following sections. 
 
 

General Information 
Computer Hardware 

Insight makes use of data and programs stored on computer hard disk drives.  Computer hardware 
including the hard disk drive is subject to daily wear and tear that can eventually result in hardware 
malfunction or dysfunction.  It is strongly recommended that all contents stored on hard disk drives 
be backed up regularly according to site and or industry standards. 

Please follow instructions provided by the computer hardware manufacturer or vendor on 
performing appropriate maintenance and updates. 
 
 

 

User Name and Password 

Access to Insight is restricted using the GCMSsolution user list for GCMS data and 
LabSolutions user list for LCMS data. When GCMSsolution or LabSolutions LCMS ins not 
installed, the user list configured in Application Configuration will be used. Please register all 
users requiring access to the Insight system on the GCMSsolution user management 
database, Insight user management system or LabSolutions user management database with 
appropriate passwords 

 

Reviewing Results 

In order to prevent erroneous results being reported and approved, please 

-confirm that the intended data file is being used 

-confirm that the expected compound is identified based on information such as the retention 
time and MS spectra. 

. 
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1 Application Configuration 

 

1 Application Configuration 

The Application Configuration is used by the System Administrator to change each setting to 
LabSolutions Insight. 

Click on the Application Configuration icon to launch the application. 

A Login page will appear: Enter the password (Default: admin) to enter.  

  

International Option: Click 'English' to change between different languages. 

1.1 General Information about Configuration 

The configuration settings can be changed by the administrator here. 

The items that can be configured are organized into sets. 

Click on the configuration button to reveal a selection. 

  

Common General settings common to all Insight software.   

In order to edit any of the items, click on the Edit button.  If you 
access any of the configuration items without clicking on the Edit 
button, the items will be shown as read-only. 

 

 

 

LabSolutions Insight Settings particular to LabSolutions Insight. 

 

Insight configuration parameters are shared across all master servers on the local network.  A 
server is a PC on which LabSolutions Insight is installed.  A master server is the reference server 
from which all servers get their configuration information from.  If clicking the Edit button shows the 
error message below, restart the PC to re-establish network connection. 
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Note that closing the application with unsaved changes will show a warning message box: 

 

Select [Yes] to close Application Configuration without applying the changes.  Select [No] or 
[Cancel] to return to Application Configuration main window. 

 

1.2 Common - General 

  

 

Below is a list of settings that can be changed. 
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Edit Users View and edit information about Insight users.  The administrator is the only 
default user.  The administrator account is used for logging into Application 
Configuration. 

Control Identification Policy Edit the method to identify the special control sample types (flag group) 
used for flag setting. 

Click on the […] button at the right end of the cell or double click in the field 
to open the Control Identification Configuration dialog box. 

Blank Identification Policy View and edit information on how the special blank sample types (i.e. flag 
groups) are identified for flagging. 

Click on the […] button or double click in the field to launch the Blank 
Identification Configuration dialog. 

Allow Language Selection Shows or hides the language selection tool in the Display Settings form of 
Insight. 

Click in the field to drop down the options. 

Export Results Default Folder Set the default folder where the export result file is saved. The folder is 
selected as the default folder of the export result file. 

Integrate Imported Sample 
Data Files 

Select whether the peak integration and quantitation is performed or not 
when the data is imported. 

Average Reference Ion 
Ratios on Load 

Averages measured reference ion ratios across all samples and updates 
the set reference ion ratio with the calculated average before performing 
peak processing and quantitation. 

Export files should be 
LabSolutions compatible 

LabSolutions Compatibility displays  “——“ or N.I.(low) / N.I.(high) in conc. 
column. 

 

1.3 Common – Display Settings 

  

 

System Font Settings Manage the system font settings. 

Click on the […] button or double click in the field to launch to Font 
Settings dialog. 

Flag Colors Manage the flag color settings. 
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Click on the […] button or double-click in the field to open the Select 
Colors dialog box. 

Displayed Number 
Formats 

Manage the format settings to display values. 

Click on the […] button or double-click in the field to open the 
Displayed Number Formats dialog box. 

Show High Accuracy 
Statistics 

Select the level of accuracy of the statistics calculation. 

 

Select [Yes] to calculate %RSD and Standard Deviation to at least 
6 decimal places. 

 

Select [No] to calculate %RSD and Standard Deviation to the same 
accuracy as the data for which the statistics are calculated. 

Use LabSolutions 
Rounding Algorithm 

Use either the LabSolutions rounding algorithm or Insight’s own 
rounding algorithm. 

 

Selecting the LabSolutions rounding algorithm will ensure all 
calculations perfectly match between Insight and LabSolutions.  
Using Insight’s own rounding algorithm may result in occasional 
(but rare) discrepancy between Insight and LabSolutions calculation 
results.  The differences, if any, appear in the least significant 
figures of calculation results.  

Using the Insight algorithm will ensure complete consistency with 
previous versions of Insight. 

1.4 LabSolutions Insight – General 

This section is for configuring items unique to LabSolutions Insight. 
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Network Settings View and edit network information.  This is required if the system is 
to work across a local network.  If the local computer has multiple 
IP addresses assigned, use this setting to specify the IP address 
that will be used by Insight.  There is no need to do this 
configuration if there is only one IP address. 

Click on the […] button or double click in the field to launch the 
Network Settings dialog. 

Shared Configuration Configure where the shared configuration will be shared from.  The 
shared configuration can be shared by the local system or some 
remote system specified by an IP address.  

Click on the […] button or double click in the field to launch the 
Shared Configurations dialog. 

Shared LabSolutions 
Insight browser 

Set up a shared folder for sharing Insight across a network.  When 
Insight in the folder is invoked, the Insight can be used in a 
computer where Insight is not installed. 

Click on the […] button or double click in the field to launch the 
Shared Browser dialog. 

Licensor Server 
Information 

View information about licenses installed on this PC. 

Click on the […] button or double click in the field to launch the 
Licensor Server Information dialog. 

Set Processing Mode  Set whether to work in Processing mode or Data mode.  Also set 
whether to enable audit trail when in Processing Mode.  

Click on the […] button or double click in the field to launch the [Set 
Processing Mode] dialog. 

Reset User Settings Initialize the window position and table columns displayed to factory 
default. 

Show Audit Trail Menu Select [Yes] to show the Audit Trail menu item in the [View] menu 
band in Insight.  This option is set to [No] by default. 

1.5 Archive Configuration 

All the settings in the [Application Configuration] can be archived (i.e. backed-up) so that if 
necessary these can be restored at a later date. The archive dialog is opened by clicking on the 
Archive button on the main window. 
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Archive Folder Type in the full path to the archive folder or press the […] button to choose 
from the standard folder selector. 

New 

Name Use the default archive name or type in a new one. 

Description Type in a brief description of the archive for easier identification when 
looking for archives to restore from.  This can be left empty. 

[Archive] Press the [Archive] button to archive the current settings to the selected 
folder with the selected name. 

Existing 

[Delete] Select an archive in the [Existing] list and press the [Delete] button to 
delete the archive. 

A confirmation dialog is shown: 

 

Select [Yes] to delete the archive and [No] or [Cancel] to keep the archive. 

[Restore] Select an archive in the [Existing] list and press the [Restore] button to 
restore the configuration to the selected archive.  This will first create an 
autosave backup of the current configuration before restoring the selected 
existing archive. 

 
Note that if the current configuration has been modified but not applied the following dialog will be 
shown when you press the Archive button: 

 

Select [Yes] to discard any changes made to the Application configuration and proceed to open the 
[Archive Configuration] window.  Select [No] or [Cancel] to stay in the main [Application 
Configuration] Window.  Select [Apply] before attempting to configure the archiving options to avoid 
this message. 

 

1.6 Edit Users 

LabSolutions Insight utilizes three different ways in which to handle user information. 

When handling GCMS data, either Insight user management database or GCMSsolution user 
management database will be used 

For LCMS data, user management can be done by either Insight or LabSolutions (via Insight).    
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1.6.1 When LabSolutions LCMS and GCMSsolution Are Not 
Installed  

Insight user management database is used when handling LCMS data without installing 
LabSolutions LCMS or GCMSsolution. 

See section 1.2 “Common - General” on how to launch the User Configuration window. 

 

The Administrator is a default user added by Insight on installation.  This user cannot be deleted. 

（Only password change is possible.） 

Use LabSolutions User DB Select whether to use LabSolutions’ user management 
database. 

User name Name used to log into Insight. 

Password Password used to log into Insight.  Only for the default 
Administrator, the same can be used to log into Application 
Configuration. 

Confirm Enter the password again to confirm. 

Display name The name displayed on Insight’s title bar as the currently logged 
in user. 

To email If the software being configured has the ability to send email 
notifications, the notification will be sent to this address. 

CC email If the software being configured has the ability to send email 
notifications, the notification will be CCed to this address. 

Edit Method Files Select whether to allow the user to edit methods. 

 

To add users, click on the [New…] button. 
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Fill in the details of the new user then click [OK]. 

To delete a user, select the user in the list then click on the [Delete] button.  Admin cannot be 
deleted. 

1.6.2 When LabSolutions LCMS and GCMSsolution Are Installed 

 

When LabSolutions LCMS or GCMSsolution is installed, the user management database will be 
used and Insight user management database will not be used. Please manage users using the 
LabSolutions LCMS or GCMSsolution user management functionality. 
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1.7 Control/Blank Identification Policy 

Blank samples and control samples can be used as a special type of blank and control when a 
specific string is included in the filename, sample ID, or sample name. Because the procedure to 
specify them is common, this section only describes the [Blank Identification Policy] settings. 

Certain blank samples can be defined as special types of blank samples.  This is achieved by 
looking for identification keywords in the GCMSsolution or LabSolutions data fields. The blank 
sample type can be used as a flag group for flagging criteria. 

See section 1.2 “Common - General” for how to launch the [Blank Identification Configuration] 
window. 

 

 

Blank Identifier Field 

Filename Look for the Blank Identification Text in the sample’s data file 
name. 

For example, if the Blank Identification Text is “water”, the sample 
in the data file Pesticides_water.qgd(lcd) will be recognised as a 
Water blank whereas Pesticides_unknown.qgd(lcd) will not be. 

Sample ID Look for the Blank Identification Text in the sample’s Sample ID 
field in the GCMSsolution or LabSolutions data file. 

For example, if the Blank Identification Text is “water”, the sample 
with the Sample ID PEST_water will be recognised as a Water 
blank whereas PEST_UNK1 will not be. 

Sample Name Look for the Blank Identification Text in the sample’s Sample Name 
field in the GCMSsolution or LabSolutions data file. 

For example, if the Blank Identification Text is “water”, the sample 
with the Sample Name Pesticides_water will be recognised as a 
Water blank whereas Pesticides_unknown will not be. 
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Select the appropriate buttons to perform the desired operations: 

Blank Identification Text 

[New…] Add a new blank identification policy. 

 

[Edit…] Edit the selected identification policy. 

This button is only enabled when an existing blank identification 
policy is selected. 

[Delete] Delete the selected identification policy. 

This button is only enabled when an existing blank identification 
policy is selected. 

A confirmation message is shown.  Select [Yes] to delete the 
selected identification policy.  Select [No] or [Cancel] to keep the 
selected identification policy. 

 

 

1.7.1 New Identification Policy 

Click on the [New…] button on the Blank Identification Policy Configuration dialog to show the New 
Blank Identification Policy dialog. 

 

 

Blank Type The name of the new blank type to be configured here. 

The Blank Type cannot be left blank. 
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Press [OK] to go back and enter a valid Blank Type. 

Blank Types must be unique so if the specified Blank Type already 
exists, an error message will be shown. 

 

A similar message is shown if the specified Blank Type is one of the 
GCMSsolution sample types. 

 

In both cases, select [OK] to go back and enter a valid Blank Type. 

Identification Text The text to search in the specified data field to identify a blank 
sample as the new blank type. 

The Identification Text cannot be left empty: 

 

Select [OK] to enter a valid Identification Text. 

 

Once the Blank Type and Identification Text are entered successfully, select either [OK] or [Cancel]. 

[OK] Save the new Blank Identification Policy and return to the Blank 
Identification Configuration dialog. 

[Cancel] Discard the new Blank Identification Policy and return to the Blank 
Identification Configuration dialog. 
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1.7.2 Edit Identification Policy 

Select an existing Blank Identification Policy and click on the [Edit…] button to show the [Edit Blank 
Identification Policy] window. 

 

Identification Text The text to search in the specified data field to identify a blank 
sample as the new blank type. 

The Identification Text cannot be left empty: 

 

Select [OK] to enter a valid Identification Text. 

 

Once the Identification Text is successfully changed, select either [OK] or [Cancel]. 

[OK] Save the new Blank Identification Policy and return to the Blank 
Identification Configuration dialog. 

[Cancel] Discard the new Blank Identification Policy and return to the Blank 
Identification Configuration dialog. 

 

 

  

 

 

Common names cannot be used in Control Identification Policy and Blank Identification 
Policy. 
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1.8 Allow Language Selection 

Set whether to show the language selection tool in the Insight [Display Settings] window. 

Click in the field to show a drop down menu.  Select [Yes] to show the language selection tool and 
[No] otherwise.  

 

1.9 Network Settings 

See section 1.4 “LabSolutions Insight – General” for how to launch the Network Settings window.   

If the local computer has multiple IP addresses assigned, use this setting to specify the IP address 
that will be used by Insight. There is no need to use this setting if there is only one IP address on 
the local PC. 

 

Select [Use The Following IP Address] to enable the option to customize the network settings.  
Either type an IP address directly into the text box or press [Find IP Addresses…]. 

 

Choose the appropriate IP address and press [Select]. 

Similarly, select [Use The Following Port Number] in order to customize the port to use. 

Press [OK] to apply the changes. 
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1.10 Shared Configuration 

The Common settings can be shared across the local network.   

See section 1.4 “LabSolutions Insight – General” on how to launch the Shared Configuration dialog. 

 

From The Local 
System 

Select this option to make the current PC the Master server. 

From The 
Following System 

Select a different server as the Master server.   

Either type in the IP address or the PC name of the Master server or click 
on the Find Systems… button. 

Find Systems… Click on this button to search for local systems that can be a Master 
server.  A list of candidates is shown in a popup window.  The search 
may take a few moments. 

 

Select a system and click on [Select] or double click on the selected 
system to designate a system in the list as the Master server.  The 
selected system name will be entered in the edit box. 

Alternatively, click on [Cancel] to cancel the selection process. 

 

Click on [OK] to confirm the settings or click on [Cancel] to discard the changes. 
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1.11 Shared LabSolutions Insight browser 

See section 1.4 “LabSolutions Insight – General” for how to launch the Shared Browser window. 
When Insight in the folder is invoked, the Insight can be used in a computer where the Insight is not 
installed.  

 

Click on the […] button to launch a folder selector window or type in the edit box directly. 

It is preferable to choose a location that is not user-dependent, such as the Desktop, but a generally 
accessible location such as C:\LabSolutionsInsight\Shared. 

If Insight is to be shared across subnets, set up the licensing system information. 

Click on the [Advanced…] button to launch the Advanced window. 

 

By default, Insight will search for licenses automatically.  In order to cross subnets, set up the 
Preferred Licensing System. 

Fill in the Static IP Address of the Server PC and the port number as appropriate. 
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Fill in the System Name or alternatively, click on the Find Systems… button to search for available 
systems. 

 

Click on the system which has the Insight license(s) installed and click on Select. 

 

Click on Test System to test that the current settings are correct. 
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1.12 Licensor Server Information 

See section 1.4 “LabSolutions Insight – General” for how to launch the Licensor Information window. 

The Licensor Server Information window shows licenses available on the system and who the 
licenses are assigned to. 

 

[Refresh] Refresh the license list.  This may take a few moments. 

 

[Advanced…] This button is displayed only when Insight cannot find a license. 

See section 1.11 "Shared LabSolutions Insight browser” on how to use 

this function. 

[Close] Close this dialog. 

 

1.12.1 Installed Licenses 

The Installed Licenses table displays the types and number of licenses installed on this network 
system.  The table contains the following columns: 

Type The type of license issued. 

 

Installed Count The number of licenses currently installed on this pc. 

 

Issued Count The number of licenses that are currently issued on this network 
system. 

 

Available Count The number of licenses available on this network system. 
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1.12.2 Issued Licenses 

The Issued Licenses table displays details of licenses issued by this computer to the local system 
and other systems on the network.  The table contains the following columns: 

Licensee The host name of the system that has been issued the licenses. 

Types The types of licenses installed on the system. 

 

1.13 Setting Processing Mode 

LabSolutions LCMS or GCMSsolution keeps analysis results in each data (*.lcd or *.qgd file).  
Insight can also keep analysis results in each data (called the Data mode) or alternatively, it can 
collectively manage a set of data analysis results and their analysis parameters in one file (called 
the Processing mode). 

See section 1.4 “LabSolutions Insight – General” on how to launch the window to set this option.  A 
detailed explanation of the Processing mode is given in section 2.1 “Operation modes”. 

  

Data Mode 

Processing Mode 

Data Mode : Insight opens LabSolutions files only. 

Processing Mode : Insight opens the processing file in addition to 
LabSolutions files. 

[Apply audit trail function 
when creating 
processing/ method file] 

Select whether to keep track of changes made to processing files 
and method files (audit trail).  Processing files and method files 
created after this option is checked will be audit trailed. 

Check this option in order to comply with regulations such as FDA 
Part11. 

Use Smart Data 
Reduction files (*.lrdz) 

Enable this option when Smart Data Reduction is used at the time 
of acquiring data using LabSolutions.   

When this option is enabled, only Smart Data Reduction data files 
and processing files created from Smart Data Reduction data files 
can be read. 

Quant Wizard Version Select which version the Quant Wizard should run in. 

For details, please see section 3.2 [File] Wizard (Processing Mode). 

[OK] Save the settings and return to the [Application Configuration] main 
window. 

[Cancel] Discard the changes and return to the [Application Configuration] 
main window. 
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1.14 Font Settings 

The font setting can be changed from the window shown below.  

See section 1.3 "Common – Display Settings” on how to launch this window. 

 

[Set Default] This button is enabled only if the currently selected font is not the 
system default. 

Select this button to apply the system default font. 

[OK] Select this button to keep the new font and return to the main 
[Application Configuration] window. 

[Cancel] Select this button to discard any changes made to the font settings 
and to return to the main [Application Configuration] window. 

Clicking on […] will open the font dialog. 

Any changes made to the font settings will only be applied to Insight after selecting [Apply] button or 
the [OK] button on the main Application Configuration window. 

 

Select a font, font style, size and script and click [OK] to keep the changes. Select [Cancel] to return 
to the Font Settings window without applying any changes. 
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1.15 Flag Colors 

The settings for the flag color to be used in the flag function can be changed in the window shown 
below. 

See section 1.3 “Common – Display Settings” on how to open this window. 

 

[OK] Select this button to keep the new flag color and return to the main 
[Application Configuration] window. 

[Cancel] Select this button to discard any changes to the flag color settings and 
to return to the main [Application Configuration] window. 

Clicking on the [Color] column for flag color setting opens the dialog box to specify the color. 

Any changes made to the flag color setting is applied after clicking [Apply] or [OK] in the main 
[Application Configuration] window. 

 

1.16 Displayed Number Formats 

The settings for the format to display values used on the application can be changed in the window 
shown below. 

See section 1.3 “LICENSE.Common – Display Settings” on how to open this window. 
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[Use Defaults] Select this button to reset the format to display values to the default. 

[OK] Select this button to keep the new format setting and return to the 
main [Application Configuration] window. 

[Cancel] Select this button to discard any changes to the format settings and to 
return to the main [Application Configuration] window. 

 

[Display Type], [Decimal Digits], [Significant Digits], and [Rounding] can be specified for each 
value. [Significant Digits] can be specified when [Display Type] is set to "Default" or 
"Exponential," and [Significant Digits] can be specified when [Display Type] is set to 
"Significant Figures". [Rounding] can be specified for all values. 

 

[Display Type] Specify the format to display values. 

Select from among "Default," "Exponential," and "Significant Figures." 

[Decimal Digits] The number of digits to be displayed after the decimal point can be 
specified when [Display Type] is set to " Default " or " Exponential." 
Enter an integer 0 to 8 in " Decimal Digits." 

[Significant Digits] " Significant Digits " can be specified when [Display Type] is set to " 
Significant Figures." Enter an integer 0 to 8 in " Significant Digits." 

[Rounding] "Rounding" can be specified for the digit number specified in " Decimal 
Digits " or " Significant Digits." Select "Half Adjust" "Round Up," or 
"Round Down." 

 

Any changes made to the format setting for values to be displayed is applied after clicking 
[Apply] or [OK] in the main [Application Configuration] window. 
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1.17 Report template management 

 

The report template used in LabSolutions Insight is managed in Report Configuration 
application. Please refer to the Report Configuration manual. 
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2 LabSolutions Insight General Information 

 

2 LabSolutions Insight General Information 

This section gives some general information useful in operating LabSolutions Insight.  The 
layout and general usage of the main window, the idea of flags and the proprietary data format 
are described. 

Both Insight LCMS and Insight GCMS are ready in LabSolutions Insight. 

 Insight LCMS handles LabSolutions LCMS files(lcb, lcd, lcmfle). 

 Insight GCMS handles GCMSsolution files(qgb, qgd, qgm file). 

2.1 Operation modes 

LabSolutions LCMS and GCMSsolution stores analysis results in each data file (*.lcd files and *.qgd 
files). 

It is possible to choose whether to store the results in the data files (Data mode) or to store the set 
of data processing results, processing parameters and calibration curve information in a single file 
(Processing mode). 

To switch the data processing mode, refer to "Enable Processing Mode” 

 

2.1.1 Data Mode 

LabSolutions LCMS or GCMSsolution stores integration results and quantitation results in the data 
(*.lcd / *.qgd) files and calibration information obtained from analysing standard samples in method 
(*.lcm / *.qgm) files.  In Data mode, Insight stores necessary information in data files and method 
files. The following explanation will use LCMS as an example, but the same applies to GCMS as 
well. 

Therefore, results processed by Insight can be read and reprocessed by LabSolutions LCMS and 
vice versa. If some functionality available in LabSolutions but not available in Insight must be used, 
it is necessary to use the Data  Mode, but otherwise, it is recommended that the Processing Mode 
explained later is used.  

 

Benefits ⚫ Insight processing results can be viewed in LabSolutions. 

Points to 
consider 

⚫ Only one analysis results can be stored in a data file.  
⚫ When storing the results of analysing using a set of varying 

parameters, all associated data files need to be copied.  
⚫ When analysis results are saved, the original data file date 

and time gets updated. 

 

Data file (*.lcd) 

 

Method file (*.lcm) 

 

Data file: Stores chromatograms, spectra and analysis results 
Method file: stores instrument parameters, analysis parameters and 
calibration information 
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2.1.2 Processing Mode 

In Processing mode, all analysis results produced by Insight are stored in the LabSolutions Insight 
Processing file (*.iproc) (processing file for short). This file type is common to LCMS and GCMS. 

Processing files store the following information: 
⚫ Analysis parameters (integration parameters, quantitation parameters, compound table etc.) 
⚫ Flag parameters 
⚫ Calibration curve information when performing quantitative processing 
⚫ Peak integration results (peak table) for the set of data files 
⚫ Quantitation results for the set of data files. 
⚫ Flagging results 
⚫ Audit trail information 

However, LabSolutions LCMS cannot handle processing files so Insight’s analysis results cannot be 
processed using the Quant Browser in LabSolutions LCMS, for example. 
 

In this mode, Insight stores analysis results in the processing file and then reads the results again 
from the processing file.  As an exception, Insight uses the analysis results in the data files and the 
calibration information in the method file when building the processing file for the first time for a 
particular set of data.  In other words, just after switching to Processing mode using Application 
Configuration, Insight uses the analysis results stored in the data files and method files to create the 
processing files. 

 

Benefits ⚫ Multiple processing files can be created for a set of data 
files.  

⚫ Analysis results from a collection of data files are stored in 
a single file for easier presentation and interpretation.  

⚫ Original data and method files are unaffected when 
analysis results are saved. 

Points to 
consider 

⚫ Insight is required to view Insight processing results. 

 

Processing file: Stores analysis parameters, analysis results, calibration 
information etc. for a set of data.  
Multiple processing files can be created and stored for a 
set of data. 

Data file (*.lcd) 

 

Method file (*.lcm) 

 

Processing file  
(*.iProc) 

Read chromatograms and 
spectra from data files. 

Data file: Stores chromatograms and spectra 
Method file: Stores instrument parameters 
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2.2 Log-in 

Launch LabSolutions Insight by double clicking on the Insight icon on the desktop. Alternatively 
launch Insight from Windows Start menu. 

Type in or select in the drop down list the appropriate user name and type in the password.  The 
user names and passwords must be the same as those for logging into GCMSsolution, 
LabSolutions or Insight. 

Below are the default users available at the time of installation: 

Pre-installed system User ID  Password 

GCMSsolution Admin (blank) 

LabSolutions Admin (blank) 

none admin admin 

 

  

If Insight is configured to allow users to change the language, there will be a hyperlink on the top 
right corner indicating the current language.  Click on the hyperlink to show a list of languages to 
choose from.  Currently, Insight supports English and Japanese. 

See section 1.2 “Common - General” on how to enable/disable language selection. 
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2.3 Main Window 

There are, in large, two parts to the main window; the menu bar on the left and the rest of the 
window which is used for displaying data.  The menu bar and data panes are described briefly 
below. 

2.3.1 Display 

The display consists of the menu bar on the left, the top data pane for showing quantitative results 
and the bottom pane for showing additional information. 

 

 

Pane layout can be customized by floating and or docking each pane.  Here, brief description of 
each pane is given assuming the default layout.  See sections 2.3.3 “Data panes” and 3  
“LabSolutions Insight Functions” for details.  

The top pane is divided into the left and right panes.  The type of information shown in each pane 
depends on the selected view. 

Compound View Top Left pane [Sample List] pane 

 Top Right pane [Compound Results] pane 

Sample View Top Left pane [Compound List] pane 

 Top Right pane [Sample Results] pane 

Summary View Top pane [Summary] table pane occupies the entire top pane 

 

The bottom pane shows chromatograms.  The following two views are available and they can be 
switched by selecting the appropriate tab. 

Compound Details Show chromatograms and calibration curve for one compound. 

Survey Show all compound chromatograms for all samples. 

QC chart or calibration curve can be displayed in the bottom pane. 
Calibration Curve Show the calibration curve for one compound and residual plot. 

Top Left Pane Top Right Pane 

Top Pane Menu Bar 

Bottom Left Pane Bottom Right Pane 

Bottom Pane 
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QC Chart Show a graph in which the quantitative values are plotted or error bar. 

 

2.3.2 Menu bar 

The menu bar is on the left of the main window which comprises a set of menu “bands” holding 
buttons for performing related operations. One menu band is reserved for user-definable 
“Shortcuts”, into which the most commonly-used tool buttons may be grouped. 

The menu bar can be collapsed by clicking on the divider. 

Depending on the window size, all the menu buttons cannot be shown. Click on the bottom right 
button to show all the buttons. 

            

 

Shortcuts Shortcuts menu band with favourite items 

 
File 

 

File menu band with file-related operations. 

 

Open 

Open a batch file and a DAMLP file. 

 

Load Method 

Load a method file. 

 

Load Flags 

Load flag setting and setting to hide compounds from the DAMLP file. 
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Import 

Import Unknown type data files. 

 

Save 

Save current work. 

Not available in Read Only mode. 

 

Save as 

Save the current method file and DAMLP file under a new name. 

 

Save Flags 

Save the current flag settings as a DAMLP file. (Processing Mode only) 

 

Export 

Export results and method to file or text.  

[Results to File] Export quantitative results as text. 

[As New Method] (Processing mode only) Save quantitation parameters 
and compound table information to a new LabSolutions 
method (*.lcm) file. This can be used to run acquisition 
based on analysis done in Insight. 

 

 

Close 

Close current batch, data and method files. 

 
View 

 

View menu band with view-related operations. 

 

Compound 

Sample 

Summary 

 

Switch between three different views. 

 

Flags Filter 

Outliers or Review 

Outliers only 

Review only 

No Outliers or Review 

All 

Filter results according to flag status. 
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Compound Details 

Launch Compound Details pane. 

 

Calibration Curve 

Launch Calibration Curve pane. 

 

Survey 

Launch Survey pane. 

 

QC Chart 

Launch QC Chart pane. 

Select whether to show [Levey-Jennings chart] or [Error bar chart]. 

 

Settings 

Configure display settings. 

 

Audit Trail 

Audit Trail setting can be changed. 

Show the audit trail log saved in a file. 

 
Edit 

 

Edit menu band with edit-related operations. 

 

Edit Method 

2.3.2.1.1.1.1.1.1 Edit Integration, Identification and Quantitation parameters. 

 

 

Integrate Batch 

Perform automated peak integration on all compounds in all samples. 

Unavailable if the data file is opened in Read Only mode or if the user does 
not have edit rights. 

 

Integrate Sample 

Perform automated peak integration on all compounds in the current 
sample. 

Unavailable if the data file is opened in Read Only mode or if the user does 
not have edit rights. 

 

Integrate Compound 

Perform automated peak integration on the current compound in the all 
sample. 

Unavailable if the data file is opened in Read Only mode or if the user does 
not have edit rights. 

 

Integrate Result 

Perform automated peak integration on the current compound in the 
current sample. 
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Unavailable if the data file is opened in Read Only mode or if the user does 
not have edit rights. 

 

Edit Table 

Edit settings in the sample list or quantitative results table. A  mark is 
added to the item name in the table when the value can be edited. 

Unavailable if the data file is opened in Read Only mode or if the user does 
not have edit rights. 

 

Edit Flags 

Edit flag criteria. 

 

Operates in read-only when the user does not have edit rights. 

 

Hide compounds 

Select compounds not to be displayed on the table. 

Review Review menu band with review-related operations. 

 

Accept 

Change the status of the selected result to Accept. 

 

Rerun 

Change the status of the selected result to Rerun. 

 

Pending 

Change the status of the selected result to Pending. 

 

Send 

Determine the status and save the DAMLP file. 
This is enabled when the HL7 option software is installed. 
Unavailable if the data file is opened in Read Only mode or if the user does 
not have edit rights. 
Unavailable when Edit Tables mode is ON. 

 
Report 

 

Report menu band with print-related operations. 

 
Reports 

Select the report template and print reports 

 

Report 

Print GCMSsolution or LabSolutions report.  Report is printed using the 
report format stored in the selected data file.  

This option is unavailable if neither GCMSsolution nor LabSolutions is 
installed. 

(Data Mode only) 
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2.3.3 Data panes 

All data panes can be pulled out to float or docked in any user-defined region. The proportions of 
the client area assigned to each pane can be adjusted by grabbing and dragging their borders. 

Below are explanations of the panes as they appear by default. 

Top Left pane This pane holds the primary list for listing items to choose the quantitation 
results by.  In Compound View, the samples (data) are listed here.  In 
Sample View the compounds are listed here. 

The pane is only available in Compound or Sample views. 

Top Right pane This pane holds the results table for listing quantitation results for the 
selected item in the left pane.  For Compound View this lists the 
quantitation results for each compound.  For Sample View, this lists the 
quantitation results for each sample. 

The pane is only available in Compound or Sample views. 

Top pane This is used to show a grid of results for all compounds and all samples.   
The pane is only available in Summary view. 

Bottom Left pane This pane is used to show the chromatograms, and QC chart. If this pane 
is not shown, click [Compound Details], [Survey], or [QC Chart] to show the 
pane. 

Bottom Right pane This pane is used to show the calibration information.  If this pane is not 
shown, click [Calibration Curve] to show the pane. 

Bottom pane This pane is used when either all tabs in the Bottom Left pane are disabled 
or when the calibration curve is not showing. 

2.3.3.1 Docking panes 

Floating forms may be docked back inside the main form client area at a number of target positions 
- docked to left-hand side, right-hand side, top and bottom or into the middle of the client area. 

If a docked form already exists in the target position, then the new form will be added as a new tab 
in that position. 

Default Layout 
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Changing Layout 

 

 
Grabbing pane header and moving the mouse floats out the pane.  

Dock indicators are shown so that the pane can be docked back into the main window.  

 

Dock Left 

Drag the pane over the left dock indicator and release it. 
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Floating pane is now docked left. 

 
 

Similarly, floating panes can be docked in all directions and locations in accordance with the dock 
indicators.  

 

 

2.3.3.2 Docked Captions and Menus 

When a pane is docked, it will display a mini caption to facilitate dragging and floating out and also 
to access a pane menu to allow closure and access to Options for that pane (when available). 

Accessing a pane’s caption menu: 

Right-click on the docked pane’s caption. 

 

 

Click on the docked pane’s drop down control.  

 

 

Right-click on the floating pane’s window caption to access extended system menu. 

 

 

Docking the Sample List to the right does not change the View to Sample View.  Similarly, 
docking the Compound List to the right does not change the View to Compound View. 
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The same menu can be accessed by clicking on the icon of the floating pane’s window caption. 

 

2.3.3.3 Persistence 

When the Insight browser is closed the position and state (minimized, normal or maximized) of the 
main window is persisted along with the docked and floating window positions of the internal list, 
details and chromatograms. Then when Insight is subsequently started all of these settings will be 
restored to the same state as when the program closed.  If a second display is no longer available, 
then those windows will be brought back onto the primary or reset to default positions (as 
appropriate). 

 

2.4 Views and Panes 

LabSolutions Insight has three views by which it displays quantitative results; Compound, Sample 
and Summary.  There are also two auxiliary views for showing detailed information or for viewing 
the data in a different way.   

 

2.4.1 Compound View 

This view is for viewing results for each compound by selecting a sample of interest.  By default, the 
Sample List is in the left pane and the Compound Results are in the right pane. 
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2.4.2 Sample View 

This view is for viewing results for each sample by selecting a compound of interest.  By default, the 
Compound List is in the left pane and the Sample Results are in the right pane. 

 

 

2.4.3 Summary View 

This view is for viewing results as a grid. Values such as Concentration, Area, Area Ratio, Height 
and Retention Time are shown for all compounds and all samples.  By default, the summary is 
shown in the top pane. 
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2.4.4 Compound Details Pane 

This view is for showing peak chromatograms and calibration information for each compound.  By 
default, this view is shown in the bottom pane.  If Survey or QC Chart is also enabled, it will become 
a tab sheet in the bottom pane. 

 

The button for showing or hiding Compound Details is a toggle button.  Press it once when it is 
turned OFF (light blue) to enable the view and or to bring it to the front.  Press it once when it is 
turned ON (darker blue) and showing on top to close it. 

 

When this view is enabled, the peaks, calibration curves and residual plots are shown for the 
currently selected Compound from the currently selected Sample. Only a single instance of a 
Compound Details is shown at any time. Its contents are automatically refreshed when a different 
sample or compound is selected in the results. 
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2.4.5 Survey Pane 

This view is for comparing chromatograms across compounds.  Chromatograms are shown as tiles 
with compounds listed in the vertical direction and samples in the horizontal direction. It can be 
changed to a tile format where samples are listed in the vertical direction and compounds in the 
horizontal direction. By default, this view is shown in the bottom pane.  If Compound Details or QC 
Chart is also enabled, it will become a tab sheet in the bottom pane. 

 

The button for showing or hiding Survey is a toggle button.  Press it once when it is turned OFF 
(light blue) to enable the view and or to bring it to the front.  Press it once when it is turned ON 
(darker blue) and showing on top to close it. 

When this view is opened, the quantified peak for each compound in the checked sample(s) is 
shown.  

The number of peaks shown for each compound is controlled by the number of samples that are 
checked in the Sample List, Sample Results or Sample columns in the Summary Results and the 
number of compounds that are checked in the Compound List, Compound Results or the 
Compound rows in the Summary Results. If the Compound List or Compound Results are sorted 
the order of rows will be changed if Flags Filter status is toggled, then those samples that are 
filtered out appear faint or are not displayed.  In this pane, the user can select a mode where 
chromatograms are displayed in a single row or a mode where they are displayed in multiple rows 
when they do not fit in a single row. 

  

  

ZStanius
Highlight

ZStanius
Typewriter
1.3.1
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Mode where chromatograms are displayed in a single row 

 

Mode where they are displayed in multiple rows 

 

Checking the “Show selected compound only” checkbox will show a single row (a single compound) 
in the pane. The compound row shown is determined by the currently selected compound in the 
results. Similarly, selecting the "Show selected sample only" checkbox will show only the samples 
currently selected on the results table. 

 

 

 

 

 

In [Survey], specified compounds or samples are displayed in a horizontal arrangement. 
The user can select to display filtered chromatograms in gray or hide them after filtering is 
performed on a list or results table from options. 

 



 

2. LabSolutions Insight General Information 

40 

2.4.6 QC Chart Pane 

This pane displays the quantitative results of the selected compounds in a chart format. By default, 
this view is displayed on the lower pane. When [Compound Details] or [Survey] is activated, it is 
displayed on the lower pane as a tab sheet. 

 

 

The user can switch to display and hide [QC Chart] using a button on the menu band. Press it once 
when it is turned OFF (light blue) to enable the view and display it in front. Press it once when it is 
turned ON (darker blue) to close the displayed view. 

 

Select the graph to display in the [QC Chart] pane from "Levey-Jennings Chart" and "Error Bars 
Chart." This section uses Levey-Jennings Chart for explanation. For details, see section 3.18 
"[View] QC Chart”. 

 

When this view opens, the quantitative results for the compound selected on the table are displayed 
in chart format. The target quantitative values are shown on the vertical axis and sample IDs on the 
horizontal axis. The name of the selected compound is displayed in the upper left area of the chart. 
Quantitative results to be displayed can be selected by clicking the quantitative result item name in 
the upper part of the chart. Select samples to display on the chart using the checkbox for the [Chart] 
item in [Sample List] or [Sample Results]. When there are no applicable quantitative results, data 
points are not displayed. However, since applicable sample IDs are displayed, the chart is displayed 
with unconnected points. 
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Data points for the currently selected sample are displayed larger than other data points. The color, 
shape, and size of data points can be set for each sample type. The line connecting neighboring 
data points can be displayed or hidden. 

 

2.4.7 Calibration Curve Pane 

This pane displays the calibration curve and residue plot of the selected compound. By default, 
this view is displayed on the right side of the bottom pane. When [Compound Details], [Survey], 
or [QC Chart] is activated, it is displayed on the right side of them. 

 

 
 
Switch to display and hide [Calibration Curve] using a button on the menu band. Press it once 
when it is turned OFF (light blue) to enable the view and display it in front. Press it once when it 
is turned ON (darker blue) to close the displayed view. 

When this view opens, the quantitative results for the compound selected on the table are 
displayed. Calibration points on a calibration curve correspond to the samples for which [Calibration 
Curve] checkbox is selected in [Sample List] or [Sample Results] table. The [Calibration Curve] 
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checkbox is enabled when the sample type of the respective sample is "Standard" or "Control." 
(Only the "Standard" sample type is used for calibration points.) 
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2.5 Shortcuts 

Shortcuts are located at the top of the menu bar and are user-definable.  Any menu item can be 
added into the shortcuts band for quicker access. Items within the shortcuts band may be arranged 
and removed via the context menu on each item. 

Right click on any menu button to show the following context menu. 

 

Selecting this context menu adds a copy of the selected button to the Shortcut band in the Menu 
bar. 

Right click on any shortcut button in the Shortcut band to show the following context menu. 

 

 

Select Move Up or Move Down to order the shortcut buttons in the desired order.   

 

Select Remove from Shortcuts to delete the selected item from the Shortcut band.  Since shortcut 
buttons are copies, the original buttons are never lost by this operation. 

Shortcut menu items are persisted between sessions on a per-user basis. 

The status (e.g. enabled/disabled, check state etc.) between the original buttons and their shortcut 
buttons, or if it is a drop down button, the status between the original drop down items and their 
shortcut drop down items, are always synched. 

 

 

 

When selecting the topmost item in the band, Move Up is disabled.  When selecting the 
bottommost item in the band, Move Down is disabled. 
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2.6 Flags 

In the list, results and graph panes, where values are found that are out of some expected range, 
these are flagged up as such either in dedicated flag columns or beside a property in graphs. 

Please also note that even if the target compound is correctly identified, if the internal standard is 
not identified correctly, or if the calibration curve is a quadratic curve where the maxima is smaller 
than the target compound area or height and therefore does not have a solution at that area or 
height, the concentration cannot be calculated and will be shown as “0.000”.  Please be aware of 
this behaviour when applying flags to the concentration values.  

 

2.6.1 Flag colors 

Two types of colors are used to indicate flagged values: 

1. Cool colors such as blue are where the value is below the flag’s lower threshold, or where it is 
implied that an outlier must be below the set threshold. 

2. Warm colors such as red are where the value is above the flag’s higher threshold, or where it is 
implied that an outlier must be above the set threshold. 

Details of the value found and the range it exceeds are captured at the point of discovery and 
stored as flag details. The flag color can be changed in Application Configuration 

 

2.6.2 Flag types 

There are two discrete types of flags, “Review” and “Outlier”, for concentration. 

In general, the idea is that Outlier type flags indicate that there is a problem with the data integrity, 
possibly because the sample analysis had an issue or the sample preparation wasn’t carried out 
correctly, etc. 

The Review type flag indicates that the sample was analysed correctly by the instrument but the 
results indicate that the sample has failed to meet a required criterion. 

The different types of flags will be highlighted with different colors on the Browser UI and filtering is 
available for the results based on flag type. 

The only flags that are “Review” type are “Lower Conc. Review” and “Upper Conc. Review”.  

 

 

 

 

When the target compound is misidentified the flagging functionality may report outcomes 
erroneously.  In order to interpret the results correctly, please view the chromatograms 
carefully and make sure target compounds are correctly identified. 
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2.6.3 Flag ID 

When a flag is applied to a value in the results, the ID of the flag is also displayed to aid the 
understanding of the reason for the flags being raised. 

The Flag IDs are shown in the Flag ID columns in Sample List, Compound Results, Compound List 
and Sample Results. 

If multiple flags are applied, they are listed separated by a comma. 

 

The Flag IDs are defined as shown below: 

  Flag Groups 

Flag 
ID 

Corresponding Flag Unknown Standard Control Spiked Unspiked Blank 

<L Lower Conc. Limit ✓      

<R Lower Conc. Review ✓      

>R Upper Conc. Review ✓      

>L Upper Conc. Limit ✓      

RT Retention time ✓ ✓ ✓ ✓ ✓ ✓ 

RT% Retention time (%) ✓ ✓ ✓ ✓ ✓ ✓ 

IRr Ion ratio (relative) ✓ ✓ ✓ ✓ ✓  

IR Ion ratio (absolute) ✓ ✓ ✓ ✓ ✓  

R2 R²  ✓     

CR Calibration Range ✓      

BC Blank concentration      ✓ 

DF %Difference  ✓ ✓ ✓   

AC Accuracy(%) (*)  ✓ ✓ ✓   

CVc %RSD conc.  ✓ ✓    

CVa %RSD area  ✓ ✓    

SN S/N ✓ ✓ ✓ ✓ ✓ ✓ 

RC Recovery(*) ✓ ✓ ✓ ✓ ✓ ✓ 
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ISs ISTD peak area 
deviation 
(Standards)(*) 

✓  ✓ ✓ ✓ ✓ 

ISc ISTD peak area 
deviation (QC)(*) 

✓ ✓  ✓ ✓ ✓ 

TF Tailing factor 
(Symmetry factor) 

✓ ✓ ✓ ✓ ✓ ✓ 

S Saturation ✓ ✓ ✓ ✓ ✓ ✓ 

LSI Min. Library 
Similarity Index 

(Screening/Explore) 

✓ ✓ ✓ ✓ ✓ ✓ 

RTi Retention time 
(absolute ISTD) 

✓ ✓ ✓ ✓ ✓ ✓ 

RTs Retention time 
(absolute Standards) 

✓ ✓ ✓ ✓ ✓ ✓ 

eRT Lib. errRT 

(Screening/Explore) 

✓ ✓ ✓ ✓ ✓ ✓ 

RRT
% 

Relative Retention 
Time (%) 

✓ ✓ ✓ ✓ ✓ ✓ 

RRT RRT (absolute) ✓ ✓ ✓ ✓ ✓ ✓ 

<RF
D 

RF Deviation  ✓     

SI Minimum Similarity 
Index 

(GCMS) 

✓      

Conf Confidence ✓ ✓ ✓ ✓ ✓ ✓ 

ASM Asymmetry ✓ ✓ ✓ ✓ ✓ ✓ 

mDa Mass Error（mDa） 

(LCMS) 

✓ ✓ ✓ ✓ ✓ ✓ 

ppm Mass Error（ppm） 

(LCMS) 

✓ ✓ ✓ ✓ ✓ ✓ 

NAM
E 

Lib. Compound Name 

(Screening/Explore) 

✓ ✓ ✓ ✓ ✓ ✓ 

ISO Iso Score 

(Explore) 

✓ ✓ ✓ ✓ ✓ ✓ 

QR Quantitation Result ✓ ✓ ✓ ✓ ✓ ✓ 

R R  ✓     

SCR Score ✓ ✓ ✓ ✓ ✓ ✓ 

H Height ✓ ✓ ✓ ✓ ✓ ✓ 
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<Isa ISTD Peak Area 
(min) 

✓ ✓ ✓ ✓ ✓ ✓ 

>Isa ISTD Peak Area 
(max) 

✓ ✓ ✓ ✓ ✓ ✓ 

Q Q-value (min) 

(GCMS) 

✓ ✓ ✓ ✓ ✓ ✓ 

<A Peak Area (min) ✓ ✓ ✓ ✓ ✓ ✓ 

>A Peak Area (max) ✓ ✓ ✓ ✓ ✓ ✓ 

PW Peak Width (50%) ✓ ✓ ✓ ✓ ✓ ✓ 

RSE RF RSE (Curve)  ✓     

(*) These flags check the measured value is within a range rather than above or below a fixed limit.  

See section 3.27.2 "Setting flags” for detailed description of the flags. 

2.6.4 Confirming flags 

The following caption-less pop-up is displayed whenever a flag is clicked. 

 

Two levels of text are displayed, a header text identifying the sample or the compound depending 
on the current view, and the flag details. 

 The colored bar on the left gives an indication of which way the value exceeded threshold. 

To display the flag pop-up left-click on a flag icon within a cell in the list, results or summary pane.  
The caption-less flag pop-up is displayed next to the flag (like a tooltip). 

To navigate between flagged items within the flag pop-up move the mouse over a hyperlink item.  
The item is bolded to indicate the hyperlink can be activated and followed to inspect the problem 
item. 

Left-clicking follows the hyperlink.  Alternatively use the [SPACE] or [ENTER] key. 

[UP] and [DOWN] cursor keys can be used to move up and down through the list of flagged items. 
A highlight rectangle is placed around the current item, the item is bolded to indicate the hyperlink 
can be activated and followed inspect the problem item. 

To ‘peek’ and view information that is behind the flag pop-up hold down the [CTRL] key.  The flags 
pop-up is made less opaque so that it is possible to see what is behind it. 

To dismiss the flag pop-up instantly left-click outside of the pop-up.  Alternatively, move the mouse 
cursor outside of the pop-up and perform no action.  The flags pop-up will be closed after a few 
seconds (like a tooltip). 
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2.7 LabSolutions Insight file structures 

Files used by Insight differs between Data mode and Processing mode.  Their roles are explained in 
turn in the following sections.  See 2.1 Operation modes for details on the different operation 
modes. 

2.7.1 Data Mode 

In Data mode, Insight operations mainly involve the LabSolutions Insight Project file (DAMLP, 
pronounced as DAML-P, where DAML is pronounced like “camel” and P like “pea”, file for short). 

 

DAMLP file  

The names and paths of each data file in a set of experimental data and their 
method file(s) are stored as well as any applied flags (thresholds) and their 
results. 

Insight workspace can be saved to DAMLP file, and reloading can restore the 
previous workspace. 

 
 

LabSolutions data file (*.lcd, *.qgd) 

Data files created by LabSolutions. 

Data file holds chromatograms, spectra, integration results, quantitation results 
etc. Integration and quantitation results obtained using Insight will be stored in 
data files in the same way as in LabSolutions. 

 
 

LabSolutions method file (*.lcm, *.qgm) 

Method file edited by LabSolutions. 

Method file holds instrument parameters, analysis parameters and calibration 
curve information. Analysis parameters edited in Insight and calibration 
information create d by Insight will be stored in the method file in the same way 
as in LabSolutions. 

 

LabSolutions batch file (*.lcb, *.qgb) 

Batch file created by LabSolutions. 

Names of the data files obtained from a batch run and the name of the method 
file used to process the data files are stored in the batch file. 
Insight cannot edit and save batch files.  If data files are deleted or added to a 
batch, this information is not reflected in the batch file. 

 

2.7.2 Processing Mode 

In Processing mode, Insight operations mainly involve the LabSolutions Insight Processing file 
(processing file for short).  

 

Processing file 

Analysis parameters, calibration curve information and results obtained uses 
these parameters as well as the data and method file names for a set of data 
are stored.  In addition, flag settings (thresholds) and their results are stored. 

Loading a saved processing file can restore all information required by Insight to 
display the results.  Multiple processing files can be created for the same batch 
data set. 
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LabSolutions data file 

Data files created by LabSolutions. 

Insight uses the chromatograms and spectra stored in the data files.  Insight 
does not use integration and quantitation results produced by LabSolutions 
DB/CS.  (Integration and quantitation results are used only when creating new 
processing files.) 

 
Integration and quantitation results produced by Insight are all stored in the 
processing file.  The original LabSolutions data files are not altered. 

 

LabSolutions method file 

Method file edited by LabSolutions. 

Method file holds instrument parameters, analysis parameters and calibration 
curve information.   

Analysis parameters and calibration curve information edited by Insight are all 
stored in the processing file.  The original LabSolutions method file is not 
altered. 

 

LabSolutions batch file 

Batch file created by LabSolutions. 

Names of the data files obtained from a batch run and the name of the method 
file used to process the data files are stored in the batch file. 
Insight cannot edit and save batch files.  If data files are deleted or added to a 
batch, this information is not reflected in the batch file. 

 

Processing Method file 

File holding analysis parameter information. 

Processing Method file is used for loading analysis parameter information only. 

 

DAMLP file 

File holding flag (threshold) information. 

DAMLP file is used for loading flag information only. 

 

2.8 LabSolutions Insight Project File (DAMLP file) 

Part of the work done using Insight is stored in the DAMLP file and can be reused.  The role of this 
file depends on whether Insight is operating in Data or Processing mode.  DAMLP files have the 
extension “damlp”. 

2.8.1 Data Mode 

Any work done in LabSolutions Insight can be saved as a DAMLP file.  It holds information such as 
the data file references and method file references in a batch and the flagging criteria applied to the 
batch.  

DAMLP files can be loaded like batch files from the Open button or like methods from the Load 
Method button. 

2.8.2 Processing Mode 

In Processing mode, DAMLP files are used to store and load flagging thresholds.  Flag information 
shipped with methods from Shimadzu corporation can be utilized in this way. 
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DAMLP files are used when [Load Flags] or [Save Flags] in the [File] menu band are used. 

In Processing mode, analysis parameters, quantitative results and flag information are all stored in 
the processing file. DAMLP is not used in a normal flow of operations. 
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3 LabSolutions Insight Functions 

 

3 LabSolutions Insight Functions 

This section describes every operation that can be accessed via the menu items in the menu bar. 

3.1 [File] Open 

This is the primary method for loading data into Insight.  Click on the [Open] button and the 
standard Windows file selector window is shown. The file selection window differs slightly 
depending on the version and mode of Insight so they are explained in turn in the following 
subsections. 

3.1.1 GCMS Data Mode 

GCMSsolution batch file, method file, data file or a DAMLP file can be loaded.  By default, Insight 
expects to open a qgb file. 

 

3.1.2 LCMS Data Mode 

LabSolutions batch file, method file, data file or a DAMLP file can be loaded.  By default, Insight 
expects to open an lcb file. 

Use the drop down list to change the file type to filter on.  It is not possible to open a processing file. 
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3.1.3 Processing Mode 

LabSolutions batch file, method file, data file or a processing file can be loaded.  By default, Insight 
expects to open a processing file. 

Use the drop down list to change the file type to filter on.  It is not possible to open a DAMLP file. 

 

When a standard data files that are referenced directly by the selected file is missing, the 
name of the missing standard data file will be shown in Insight followed by “Not Available”.  
The data is not loaded. 

When the standard data files referred to by the method file referred to by the selected file is 
missing, a similar action is taken. 

 

When a data file other than a standard data file is missing, or if a standard data file that is not 
referred to by the method is missing, that data file is simply not loaded and its file name is not 
shown in Insight. 
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When the DAMLP file is loaded as a batch file, the Save operation will always automatically 
overwrite the current DAMLP file. 

 
When data files referred directly by or by the method referred to by the processing file, 
LabSolutions batch or method file is missing, the name of the missing data file will be shown 
in Insight followed by “Not Available”.  The data is not loaded. 

 

When a standard data file not referred to by a method or a data file other than standards 
referred to by the LabSolutions batch file are missing that data file is simply not loaded and its 
file name is not shown in Insight. 

 

When a method file is not available in the location specified in the batch file, the batch will 
open without showing any samples or compounds. 
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3.2 [File] Wizard (Processing Mode) 

The quantitation Wizard is available only in Processing Mode. 
The wizard helps create a processing method and processing results files using LabSolutions 
batch, method and data files in just 3 steps. 
 

Step 1 Select a batch file used during acquisition and select data files from the 
batch that will be used for analysis. 

Step 2 A processing method to be used for analysis can be selected from an 
existing set or created anew.  If a new processing method is to be 
created, proceed to Step 3. 

Step 3 A list of compounds registered in the acquisition method is shown. 
 
(Only LCMS) 
Using a reference data (a good and representative data from a group of 
data to be used for further analysis) and its chromatograms for each 
compound, adjust integration parameters and retention times. 

 
A processing method file (*iprom) is created once the Wizard is finished.  The browser shows a list 
of data selected in Step 1 and the quantitation results calculated based on the processing method 
parameters defined in Steps 2 and 3. 
 

3.2.1 Step1: Sample Selection 

Select the [File] menu band and click on the [Wizard] button to open the quantitation Wizard. 

  
In Step 1 of the quantitation Wizard, select a batch file or a Smart Data Reduction data file (lrdz file), 
then select the data in the batch or lrdz file to use in the following data analysis. 
Click on the [Wizard] button to select a batch file or an lrdz file. 
 
In Step 1 of the quantitation Wizard, select a batch file or an lrdz file, then select the data in the 
batch or lrdz file to use in the following data analysis. 
Click on the [Wizard] button to select a batch file. 
 

 
 
When a batch file is selected, a list of available data files is shown. 
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Data files with the left hand side check box ticked will be used for analysis.  If a data file is not to be 
used in analysis (e.g. Blank), untick the check box. 

  
Click on the right arrow button at the bottom right of the window to confirm the current selection ad 
to proceed to the next step.  Click on the Cancel button to abort the Wizard. 

 
 

 

Click on the cogwheel button to select a saved layout.  
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3.2.2 Step2: Method Selection 

 
In Step 2, select a processing method to be used in the analysis. 
To use an existing processing method to analyze this data, select the [Select method] radio button 
and click on the […] button to select the required processing method. 

 
 
Once a method file is selected, the button at the bottom right of the window becomes enabled. 

 
Click on the Check button to finish the Wizard and proceed to producing the analysis results.  Click 
on the Cancel button to abort the Wizard. 
 
To create a new processing method, select the [Create method] radio button and enter the name of 
the new processing method file to be created.  Next, select a sample to use for creating the method 
in Step 3.  The highlighted row will be used in Step 3. 
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When a valid processing method file name is entered and a sample for creating the method is 
selected, the button at the bottom right of the window becomes enabled. 

  
 
Click on the right arrow button to confirm the current settings and to proceed to the next step. Click 
on the Cancel button to abort the Wizard. 
 
Click on the left arrow button at the bottom left of the window in order to go back a step and to 
modify the settings. 

 
 

3.2.3 Step3: Update Parameters (LCMS Only) 

Only LCMS parameters can be update.  For GCMS, it is only possible to view and confirm the 
compound list. 

 
In Step 3, the chromatograms and peaks for each compound registered at the time of acquisition 
can be reviewed.  There are multiple versions of the Update Parameters page and which version to 
use can be selected in the Application Configuration.  When the version is changed in the 
Application Configuration, please restart Insight to apply the selection.   
 
If a compound is not going to be required for data analysis, untick the check box at the left hand 
side to remove that compound from further processing. 

 
 

3.2.3.1 Version 1 

 
Peak integration parameters can be updated easily by selecting peak and background regions and 
setting the smoothing level appropriately. 
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When peak integration parameters are not set appropriately, a combination of the following 
operations can help improve peak integration. 

 
 
1. Select Peak 
Enable the Peak button and click and drag a Peak Region in the chromatogram. 

 

 
 
 
2. Select Background 
Enable the Background button and click and drag a Background Region, where the signal is 
assumed to be noise, in the chromatogram. 

 

 
3. Select Smoothing Level 
Select a smoothing level if the chromatogram needs smoothing.  The larger the level number, the 
more smoothed the chromatogram will become. 
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4. Tailing Off 
Tailing processing detects smaller peaks located on top of the tail of a previous bigger peak.  This 
processing option is turned ON by default but by ticking the Tailing Off check box, it is possible to 
turn it off. 

5. Baseline Type 
Tick the [Baseline Type] check box in order to apply baseline processing and select the method by 
which to process the basline from the drop down list. 

 

For [Baseline Length] and [Valley Height Ratio], enter the appropriate parameters in the adjacent 
box.  For details on baseline processing please refer to LabSolutions DB or LabSolutions CS users 
manual or online help. 

3.2.3.2 Version 2 

 

Peak integration parameters can be updated easily by selecting the peak and setting the smoothing 
level appropriately.   

When peak integration parameters are not set appropriately, tick the [Optimize Peak Integration] 
option then a combination of the following operations can help improve peak integration. 

1. Select Peak 

Enable the Peak button and click and drag a Peak Region in the chromatogram. 
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2. Select Smoothing Level 

Select a smoothing level if the chromatogram needs smoothing.  The larger the level number, the 
more smoothed the chromatogram will become. 

 

 

Tailing processing is unaltered, and the baseline type is set to “Base to Base”. 

3.2.3.3 Calibration curve 

It is possible to configure the calibration curve by clicking on the Calibration button . 

 

Here, you can configure whether to use area or height, calibration curve type, zero through 
behaviour and weighting.  Please refer to the LabSolutions DB or LabSolutions CS user 
guide or online help for details on each of the options. 
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It is also possible to select whether to use the default calibration curve settings for all 
compounds or to configure a compound separately.  A compound for which calibration 
configuration is set separate to the default is marked with *. 

 

 

3.3  [File] Load Method 

Use this function to apply a new quantitation method. 

Click on the [Load Method] button and the standard Windows file selector window is shown.  Select 
a method to load.  A method can be a qgm file (GCMSsolution method file) or an lcm file 
(LabSolutions LCMS method file). 

In Processing mode, Insight expects to open a processing file by default.  Use the drop down list to 
change the filtering on the file type as appropriate. 
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When a method file with no compounds registered in its compound table is loaded, an error 
message is shown and that method cannot be used in Insight. 
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3.4 [File] Load Flags 

Click on the [Load Flags] button to apply a new set of flag criteria. 

When the setting to select compounds has been saved in the selected file, this setting can also be 
loaded. 

 

3.4.1 Data Mode 

Select a DAMLP file to load. 
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3.4.2 Processing Mode 

Select a processing file or DAMLP file to load. 

 

 

3.5 [File] Import 

One or more data files can be appended to an existing batch or processing file. 

Click on the [Import] button and the standard Windows file selector window is shown.  Select one or 
more data files to load. 
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3.6 [File] Save 

Work done in Insight can be saved by clicking on the [Save] button.  

 

3.6.1 Data Mode 

Data files, method files and DAMLP files can be saved. 

When a set of data is loaded into Insight without using a DAMLP file, an option to save it as a 
DAMLP file is presented. 

When data is loaded from a DAMLP file, the current file is always overwritten. 

When the data had been loaded without using a DAMLP file and a DAMLP file has been opened 
subsequently to apply flags, the Save operation will always offer to save the current data as a new 
DAMLP file. 

 

 

3.6.2 Processing Mode 

Processing files can be saved. 

If data had been loaded without using a processing file, the Save operation will always offer to save 
the current data as a new processing file. 

If data had been opened using a processing file, the Save operation will always overwrite the 
current processing file. 

When the data had been loaded without using a processing file and a processing file has been 
opened subsequently to apply flags, the Save operation will always offer to save the current data as 
a new processing file. 

If audit trail is enabled and the current data was opened without using a processing file, an audit 
trail log stating the file path of the method currently in use will be created on saving the data as a 
new processing file. 

 

 

A method file, a batch file or a processing file must be opened prior to importing data files. 

 

 

Data files appended to an existing batch can only be saved to a DAMLP file in Data mode or 
processing file in Processing mode, not to a GCMSsolution or LabSolutions batch file.  

 

 

If any one of the following are read-only, this menu item is made disabled: user rights, data 
file, method file. 
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3.7 [File] Save as 

Click on the [Save as] button to save the current work done in Insight under a new name. 

This menu item is enabled even when the method file or processing file is read-only. 

3.7.1 Data Mode 

Method files and DAMLP files can be saved under a new name. If a data file has been altered for 
example by performing manual peak integration, the current data file is overwritten and saved. 

3.7.2 Processing Mode 

The current work done in Insight can be saved to a new processing file.  Any changes made to 
methods and data files are saved to the processing file and not to each LabSolutions method and 
data files. 

 

 

3.8 [File] Save Flags 

This operation is only available in Processing mode. 

Click on the [Save Flags] button to save the current flags to a DAMLP file.  The [Save Flags] button 
becomes enabled when a new flag file is applied or when flag settings are changed or when 
selected compounds are changed.  Save Flags will always prompt to save as a new DAMLP file. 

 

 

If any one of the following are read-only, this menu item is made disabled: user rights, 
processing file. 

 

 

If audit trail is enabled and set up to ask for reasons for any changes made, Insight will 
display a window for entering the reason for change. 

See section 3.20.2 “Entering the Reason for Change” for details on being prompted for 
reason for change. 

See sections 1.13 "Enable Processing Mode (LCMS only)” and 3.19 "[View]—Audit Trail” for 
more information on setting up Insight to perform audit trail and to view audit trail logs. 

 

 

If audit trail is enabled and set up to ask for reasons for any changes made, Insight will 
display a window for entering the reason for change. 

See section 3.20.2 “Entering the Reason for Change” for details on being prompted for 
reason for change. 

See sections 1.13 "Enable Processing Mode (LCMS only)” and 3.19 "[View]—Audit Trail” for 
more information on setting up Insight to perform audit trail and to view audit trail logs. 
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3.9 [File] Export 

Click on the [Export] button to export results as text. 

In Processing mode, clicking on the [Export] button shows a drop down menu.  An additional option 
to export a method file is shown. 

 

3.9.1 Results to File 

This function provides the ability to export quantitative result information to the clipboard or Comma 
Separated Variables (csv) / Tab Separated Text (txt) /Tab Separated Variables (tsv) file.  The output 
format depends on the current results view. 

Click on the Export button to show the window below: 

  

Export Options 

Copy to Clipboard Copy the results to Clipboard.  The content can subsequently be 
pasted to third-party software such as word processing software. 

 

Output to File Write the results out to the file specified below. 

Click on the […] to select a file or type the full output file path in the 
box. 

The file name extension depends on the delimiter options: 

Tab: txt / tsv 

Comma: csv 

Delimiter Options 

Tab 
Select the required delimiter from the drop down list. 

Comma 

Columns 
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By View Select the format of the applicable export result from the drop 
down list. 

Fixed Format (Compound 
vs Sample) 

Fixed Format (Sample vs 
Compound 

 

 

Export the results using the options set above. 

 

Cancel the export operation. 

 

 

 

3.9.1.1 Format: By View (Compound View) 

This format is used when [By View] is selected for the format option and [Compound View] is 
selected for the current display setting. 

Layout is changed according to the table style of the view. 

Below is an example. The details of the format are available in “Appendix A”. 

 

 

3.9.1.2 Format: By View (Summary View) 

This format is used when [By View] is selected for the format option and [Summary View] is 
selected for the current display setting. 

Below is an example. The details of the format are available in “Appendix A”. 

 

 

Due to the specification of this software, information irrelevant to the current configuration of 
the software may be exported. 
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3.9.1.3 Format: Fixed Format (Compound vs Sample) 

This format is used when [Fixed Format (Compound vs Sample)] is selected for the format option. 

The details of the format are available in "Appendix A." 

3.9.1.4 Format: Fixed Format (Sample vs Compound) 

This format is used when [Fixed Format (Sample vs Compound)] is selected for the format option. 

The details of the format are available in "Appendix A." 

 

3.9.2 As New Method 

This menu is enabled only in Processing mode. 

Export the current method as a new method file.  The new method file can only be exported to the 
current project. 

 

Enter a name for the new method file and click on . 

3.10 [File] Close 

Use this function to close all current files. 

3.10.1 Data Mode 

If any changes have been made, an option to save them will be presented. 

If the set of data files were opened without using a DAMLP file, an option to save the data, method 
and flag files (if applicable) as a DAMLP file will be presented. 
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3.10.2 Processing Mode 

If any changes have been made, Insight will offer to save the changes to the current processing file.   

If the current data was opened without using a processing file, Insight will offer to save the current 
data as a new processing file. 

 

3.11 [View] Compound 

In Compound view, the Sample List shows the list of samples in the loaded batch and the 
Compound Results table shows the results for all of the compounds in the current selected sample.  

Click on the first button in the View menu band and select Compound from the drop down list that 
appears under the button. 

 

 

Check the checkboxes in the Sample List to include that sample in the Survey view.  The checkbox 
in the header can be used to check/uncheck all the samples at once. 
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Similarly, check the checkboxes in the Compound Results table to include that compound in the 
Survey view.  The checkbox in the header can be used to check/uncheck all the compounds at 
once. 

 

The order of the items shown in the Sample List and Compound Results tables can be changed by 
clicking on a column header to sort the list by the values under that column (for example, clicking on 
the “Sample Name” column header in the Sample List table will sort the results displayed in that list 
alphabetically by sample name). Clicking on the column header again will toggle between 
ascending and descending sort order (as is standard Windows behaviour). 

If either the Sample List or Compound Results tables are closed, they can be restored by selecting 
Compound again from the View menu band. 

 

3.11.1 Filtering 

Lists and Results can be filtered using the filter buttons located under each column header.  
Filtering only affects the visibility of the samples/compounds in the lists; it does not affect the actual 
data in the batch in any way. 

 

Filter criteria can be set by clicking on a filter icon. Filtering can be applied for multiple columns and 
the effects of each filter are combined to restrict the range of values shown within the corresponding 
list. When the filter criteria pop-up window is dismissed (by clicking anywhere outside of the popup 
window or hitting the [Return] key) the filter is immediately applied to the list contents so that the 
effects of applying that filter can be seen on the fly. 
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Once a filter has been applied for a list column, the header for that column shows details of the filter 
as shown below. If the filter description text is too long for the current column width (as the 
description for Level is in this example), then it is truncated with ellipses and a tooltip can be used to 
reveal the complete description. 

 

 

 

Click on the filter icon again to remove the current filter.  

The criteria that need to be specified in order to filter the list contents by the values under a specific 
column are dependent on the type of the column. There are six different criteria types: String, 
Numeric, Options List, Date, Status and Level. 

 

3.11.1.1 String Filtering 

For a string filter type (for example, for the “Data Filename” column), the filter criteria is set in a pop-
up window shown below. 

 

Enter a string of characters to search in the corresponding column.  Only those items containing 
exactly the specified string will be shown and the rest will be hidden.  The matching portion in the 
items listed can be anywhere in each item as long as the specified string is found as a contiguous 
and complete piece.  String filtering is case insensitive (therefore filtering on “STD” and “std” 
performs the same operation). Deleting the string in this pop-up window will remove any filtering 
applied to the corresponding column. 

3.11.1.2 Numerical Filtering 

For a numerical filter type (for example, the “Area” column), the following filter criteria pop-up 
window is shown. 

 

 

When filtering is activated, it affects the chromatograms shown in Survey.  However, the 
filtering is intended to be controlled based on the Lists and Results and not the 
chromatograms. It is advised to simply view chromatograms when filtering is activated. 



 

3. LabSolutions Insight Functions 

73 

 

All Show all items.  This is equivalent to switching off filtering. 

Above Show values greater than the specified value (not including the 
entered value). 

Below Show values less than the specified value (not including the entered 
value). 

Between Show values between the specified values (including the entered 
values). 

Not Available (----) Show the items which have no value. 

Not Available is not shown if there are no (---) in the selected 
column. 

An error icon is shown if an invalid value is entered.  Hovering the mouse pointer over the error icon 
will show a tooltip explaining the reason for the error. 

 

3.11.1.3 Options List Filtering 

When a filter is to be applied to a column that contains values that are from a list of several 
available options (such as the “Sample Type” column in the Sample List table), the following dialog 
box is shown. Only the options that are present in the table’s column data are shown in the list. 

 

Check the boxes for the items to show.  Unchecking all options listed in the filter pop-up window 
removes all filtering previously applied to the corresponding column. 

 

3.11.1.4 Date Filtering 

Date and time values can be filtered using the following pop-up window. 
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All Show all items.  This is equivalent to switching off filtering. 

After Show values after than the specified date (not including the entered 
date). 

Before Show values before than the specified date (not including the 
entered date). 

Between Show values between the specified dates (including the entered 
dates). 

 

Dates can be entered directly into the fields using the keyboard or by clicking on the down arrow 
button which will show the standard date selector pop-up as shown below: 

 

 

3.11.1.5 Status Filtering 

The Status values can be filtered using the following pop-up window. 

  

 

Pending Show the compound or sample for which the status is 
“Pending”. 

Accept Show the compound or sample for which the status is 
“Accept”. 

Rerun Show the compound or sample for which the status is “Rerun”. 

Sample List Compound Results 
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Accepted Show the compound or sample for which the status is 
“Accepted”.  

Rerun Complete Show the compound or sample for which the status is “Rerun 
Complete”.  

Sent Show the compound or sample for which the status is “Sent”. 

Complete Show the compound or sample for which the status is 
“Complete”. 

Not Available（----） Show the compound or sample for which the status is “Not 
Available”. 
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3.11.1.6 Level Filtering 

The Level values can be filtered using the following pop-up window. 

 

1, 2, 3 … （Numerical） Show the sample which has the same level.  

Not Available（----） Show the sample in which the level is “---”. 

 

3.11.2 Table style 

The configuration of columns that are shown in the Sample List and Compound Results tables can 
be edited using each pane’s caption menu and selecting the “Properties…” menu item. 

 

Selecting this menu item displays the Table Style dialog box: 
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This dialog box shows the columns that are currently selected for display in the Sample List table in 
the right hand list and the remaining available columns in the left hand list. Columns can be added 
to the “Selected columns” list by selecting one or more items in the “Available columns” list and 
clicking the right arrow button; the selected column(s) will then be added to the end of the “Selected 
columns” list.  

Selected columns List of columns currently displayed in the corresponding list or 
table.  The columns are listed in the order they appear in the 
corresponding list or table where the topmost is the leftmost and 
the bottommost is the rightmost. 

Available columns List of columns currently hidden from the corresponding list or 
table. 

 

Select a column in the Available columns list and click this button to 
send the selected column to the Selected columns list.  The 
selected column will be shown in the corresponding list or table. 

 

Select a column in the Selected columns list and click this button to 
send the selected column to the Available column list.  The 
selected column will be hidden from the corresponding list or table. 

 

Select a column in the Selected columns list and click this button to 
send the selected column up the list.  The column will be moved left 
along the corresponding list or table. 

 

Select a column in the Selected columns list and click this button to 
send the selected column down the list.  The column will be moved 
right along the corresponding list or table. 

Number of fixed columns The specified number of columns from the left side can be fixed 
from among the columns displayed in the corresponding list or 
results. 

  

Certain types of columns are mandatory and must always be present (such as the “#” [sample 
number] and “Flags” columns in the Sample List table), therefore these columns are not presented 
for configuration in the Table Style dialog box. The mandatory columns are always included at the 
start of the table, followed by the columns as configured in the Table Style dialog box.  

 

 

Reset to default settings. 

 

Apply the changes and close the Table Style dialog. 

 

Discard the changes and close the Table Style dialog. 

The Table Style settings for all tabular views can also be accessed through the Table Styles section 
of the Display Settings window. 
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3.11.3 Sample List operations 

Right click on a row in the Sample List to show the following context menu: 

 

For Pending, Accept and Rerun see  3.29 Review. 

3.11.3.1 Fixing the Y-axis 

Select [Fix Y axes] from the Sample List context menu. 

Now, the Y-axes of all the chromatograms shown in the Survey are fixed to show the selected 
sample optimally.  Using this option allows for the comparison of all sample chromatogram 
intensities against the selected reference chromatogram. 

The selected reference chromatogram is indicated by a black bar on the far left of the Sample List: 

 

3.11.3.2 Overlay plot 

Select [Overlay plot] from the Sample List context menu to specify the sample as the reference 
chromatogram. This menu is enabled only when the selected sample type is "Standard." 

The chromatogram of the sample specified in this item is displayed overlaid with all displayed 
chromatograms. The y-axis is fixed to the intensity axis of the chromatogram of the sample 
specified in this item. Using this option, all sample chromatograms can be easily compared with the 
selected reference chromatogram. 

A black bar is shown on the left side of the selected reference chromatogram in Sample List. 
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3.11.3.3 Make Calibration Curve from Selected Sample(s) 

Select at least one sample and select [Make Calibration Curve from Selected Sample(s)] in order to 
create calibration curves for all compounds. 

 

Enter standard concentrations for each level for every compound and click on the check box. The 
levels are set from 1 at the top of the list to however many samples are selected to make the 
calibration curve from. 

Here, the right click context menu item other than the standard Windows items are explained. 

Fill down Apply the selected value to all rows below. 

Sample Identifier Select which information to identify each sample by 

-Data file name 

-Sample name 

-Sample ID 

 

All samples not selected for calibration curve creation will be set to Unknown. 

 

3.11.3.4 Delete Result 

Select [Delete Result] from the Sample List context menu to delete the quantitative results of the 
selected compound. 

3.11.3.5 Removing Data Files 

Select [Remove Data File] from the Sample List context menu to remove the selected file from the 
list. 

This option is only available for non-standard samples and is therefore disabled when the current 
selected row is of “Standard” sample type. 

 

3.11.3.6 Copy 

Select [Copy] from the Sample List context menu to copy the currently selected cell. 
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3.11.3.7 Select All 

Select [Select All] from the Sample List context menu to select all items displayed in the 
Sample List. 

 

 

3.11.3.8 Copying the Table 

Select [Copy Table] from the Sample List context menu to copy the current table as tab-delimited 
text to the clipboard. 

The text can be used in 3rd party software as a table. 

 

3.11.3.9 Printing Reports 

This option is available for Data mode only. 

Select [Print Report] from the Sample List context menu to print a GCMSsolution Report or 
LabSolutions LCMS report for the selected data file. See "3.31 [Report] Report " for details. 

3.11.3.10 Properties 

Selecting [Properties…] in the Sample List context menu displays the sub-window to edit the table 
style as described in 3.11.2 Table style. 

Hint 

Drag the mouse to select a desired range. 
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3.11.4 Compound Results operations 

Right click on a row in the Compound Results table to show the following context menu: 

 

 

3.11.4.1 Deleting Results 

Select [Delete Result] in the Compound Results context menu to remove the compound result for 
the currently selected sample in the Sample List, in the same way as in GCMS Quant Browser. 

 

3.11.4.2 Copy 

Select [Copy] in the Compound Results context menu to copy the currently selected cell. 

 

3.11.4.3 Select All 

Select [Select All] in the Compound Results context menu to select all items displayed in 
Compound Results. 

 

3.11.4.4 Copying the Table 

Select [Copy Table] from the Compound Results context menu to copy the current table as tab-
delimited text to the clipboard. 

The text can be used in 3rd party software as a table. 

 

3.12 [View] Sample 

In Sample view, the Compound List shows the list of compounds contained in the samples and the 
Sample Results table shows the results for the samples for each of the compounds selected in the 
Compound List.  

Click on the first button in the View menu band and select Sample from the drop down list that 
appears under the button. 

If either the Compound List or Sample Results tables are closed, they can be restored by selecting 
Sample again from the View menu band. 
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Check the checkboxes in the Sample Results to include that sample in the Survey view.  The 
checkbox in the header can be used to check/uncheck all the samples at once. 

 

 

Similarly, check the checkboxes in the Compound List to include that compound in the Survey view.  
The checkbox in the header can be used to check/uncheck all the compounds at once. 

 

The order of the items shown in the Compound List and Sample Results tables can be changed in 
the same way as for Sample List and Compound Results in Compound View. 

Filtering of items in the Compound List and Sample Results tables is also supported in exactly the 
same way as that specified for the Compound view above. 

The configuration of columns that are shown in the Compound List and Sample Results tables can 
be edited using each pane’s caption menu and selecting the “Options…” menu item in the same 
way as that specified for the Compound view above. 

Sample List operations available in Sample View are now available in Sample Results. 

Compound Results operations available in Sample View are now available in Compound List except 
that it is not possible to delete compounds from the Compound List. 
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3.13 [View] Summary 

In Summary view the results are summarized in a single table with a row for each compound and a 
column for each sample – this orientation matches the orientation of the Survey pane. The values 
shown in the table cells correspond to a single data value for the specific sample / compound 
combination. 

Click on the first button in the [View] menu band and select [Summary] from the drop down list that 
appears under the button. 

If the [Summary Results] table is currently closed, it can be restored by selecting [Summary] again 
from the [View] menu. 

 

 

When showing compounds vs samples, the check boxes for selecting samples to display in 
[Survey] are along the top next to the sample names.  Similarly, the check boxes for selecting 
compounds are next to the compound IDs (#).  All compounds can be selected or unselected using 
the check box under the column header for Compound ID (#) as shown below. 

 

Similarly, when showing samples vs compounds, the check boxes for selecting compounds are 
displayed next to compound names across the top.  The check boxes for selecting samples are 
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displayed next to the sample IDs going down.  All samples can be selected or unselected using the 
check box under the Sample ID header. 

Filtering can only be applied to the “Flags” and “Name” columns in this table (the “Flags” and “Data 
Filename” columns when selecting “Samples vs. Compounds” orientation). The procedure for 
setting the flagging criteria is the same as for the Compound View. 

 

3.13.1 Summary Results Options 

The type of data to be displayed in the Summary table can be specified by selecting the 
[Properties...] caption menu and using the [Summary Results View Style] popup window. 

  

 

Select the items to be displayed in the Summary view here. Click [Fixed] to select the items to 
display on the fixed column on the left side of the summary table. Click [Comparison] to select the 
items to display on the comparison column on the right side of the summary table. 

 

Configure which columns to fix at the left hand side of the summary table.  
These columns will stay visible even when the table is scrolled to the right. 
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Fixed columns do not scroll: 

 

 

 

Use the left and right arrow buttons to move columns 
between the [Available columns] and [Selected columns] 
lists.  Columns listed in the [Selected columns] list will 
appear in the Summary table as fixed columns on the 
left. 

 

 

Use the up and down arrow buttons to change the order 
of the fixed columns.  The column listed at the top appear 
leftmost and the bottom at the rightmost of the fixed part 
of the Summary table. 

 

Configure which columns to compare results by.   
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A “block” of selected columns repeat for each sample or compound: 

 

 

 

Use the left and right arrow buttons to move columns 
between the [Available columns] and [Selected columns] 
lists.  Columns listed in the [Selected columns] list will 
appear side by side for each sample or compound 
column. 

 

 

Use the up and down arrow buttons to change the order 
of the fixed columns.  The column listed at the top appear 
leftmost and the bottom at the rightmost of the 
comparison part of the Summary table. 

 

The summary table orientation can also be set here. Select [Samples vs. Compounds] to have 
samples going down and compounds going across. Select [Compounds vs. Samples] to have 
compounds going down and samples going across. 

 

Setting [Filter by sample type] enables the user to narrow down the samples to display by the 
sample type. When the [Filter by sample type] checkbox is not selected, all samples are displayed. 
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When the checkbox is selected, only samples that fall under the selected sample type are 
displayed. 

 

For [Sample identifier], the label of the samples to be displayed in Summary can be selected from 
among data file name, sample name, and sample ID. 

 

Table cells relating to compounds that are not present in a particular sample are shown as such by 
the use of a series of dash characters (-----). 

 

The [Sample List] operations available in [Compound View] are now accessed through right clicking 
on a cell in the [Summary] table. 

 

3.13.2 Show Selected Columns 

It is possible to show or hide columns being compared in the Summary table directly from the table. 
Right click on the table and select the [Columns] menu. The [Columns] menu lists the quantitation 
results that have been selected to be compared in the Summary Table.  Select the required 
columns to be displayed as required.  In order to show all columns, select [All].  

 

 

 

3.14 [View] Flags Filter 

Click on the second button (Flags Filter) in the View menu band and select filtering based on the 
flags from the drop down list that appears under the button. 

The Flags Filter button is enabled only if there are flags defined. 
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When a Flags Filter is selected the contents of the lists currently being displayed will be immediately 
updated so that only samples and compounds that have the flags of the selected filter type will be 
shown. 

Selecting the Flags Filter option overrides any filtering that has already been applied to the lists. 

All existing column filtering will be removed. 

Column filtering can subsequently be applied in the usual way. 

Selecting the Flags Filter and selecting the ‘All’ option will turn the option off, all filtering will be 
removed and the entire (unfiltered) list of sample and compound results will be displayed in all 
views. 

When a particular Flag Filter is active, the Flags Filter button will change to indicate which filter is 
currently selected: 

All 

 

Show all samples regardless of their flag status. 

Outliers or Review 

 

Show only those samples with Review or Outlier flags. 

Outliers only 

 

Show only those samples with Outlier flags. 

Review only 

 

Show only those samples with Review flags. 

No Outliers or Review 

 

Show only those samples with no flags. 

 

3.15 [View] Compound Details 

The Compound Details pane can be displayed by pressing the Compound Details button in the 
View menu band. 

If the Compound Details pane is not already shown when this menu button is clicked then a new 
pane is opened. 
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If the Compound Details pane is already created, but not showing on top, clicking on this button will 
bring Compound Details to the top. 

If the Compound Details is showing on top, clicking on this button will close the pane. 

 

 

The [Compound Details] pane can display chromatograms of the quantitative ions and reference 
ions for a selected compound. It can also display chromatograms of ISTD compounds when an 
ISTD group is specified. 

 

For GCMS data, comparison chromatograms are appended to the bottom of the chromatograms.  
Please see sections 3.15.9 “Show Spectra (GCMS only)” and 3.15.10 “Show Comparison 
Chromatograms (GCMS only)” for details. 

 

The items to be displayed in the [Compound Details] pane can be specified by right-clicking the 
mouse and selecting [Properties] in the menu displayed or selecting the [Settings] button in the 
[View] menu band. 

See [3.19.2 Chromatogram] for details on the [Display Settings] dialog. 

 

A popup menu can be accessed by right clicking in the graphs. 

Undo Zoom Undo the previous zoom. 

Redo Zoom Redo the last zoom. 

Initialize Zoom Initialize the zoom to default. 

 

Copy Copy the current graph as a graphic. 

Paste Paste the content of the clipboard. 

ID Peak Display the identified peak. 

All Peaks Display peaks in the entire data acquisition time. 

Update Retention Time and Reference Ion Ratios］：update the retention 

time to the specified time on the chromatogram and the 
reference ion ratios to the actual ratio.  
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［Retention Time only］：update the retention time to the 

specified time on the chromatogram 

［Reference Ratios only］：update the reference ion ratios to the 

actual ratio. 

Select Quant Ion Select a transition (or mass) to be used as the target ion from among the 
transitions (or masses) specified for the reference ion and switch them. An 
asterisk (*) is added at the beginning of the transition (or mass) specified 
as the target ion. 

Manual Identification Manual peak identification indicator is displayed for peaks that have been 
identified. To identify a different peak as a compound peak, drag an 
indicator to the target peak using the mouse. 

Clear Identified Peak Delete peak identification results from the current chromatogram. 

Delete All Peaks Delete all peaks from the current chromatogram. 

Manual Peak Integrate Select Link Point, Horizontal or New Baseline and perform manual peak 
integration. 

Apply Peak Integration To 
All Samples 

Apply the manual peak integration process applied to the currently 
selected chromatogram to all samples. 

Properties Display the dialog box for chromatogram settings in display settings. 

 

3.15.1 ID Peak / All Peaks 

These are paired and toggled options. 

 

ID Peak will display a window of data around the identified peak(s).  All Peaks will display the entire 
acquisition duration to show all peaks. 

 

3.15.2 Update RT / Ion Ratios 

Select the set retention time on the graph area and update it. The current reference ion ratio can be 
applied as the set value. 

Update 

Retention Time and Ion Ratio* Set the retention time and update the reference ion ratio at the 
same time. 

Retention Time only* The set retention time can be selected on the graph. 

Move the mouse cursor to move the bar and click the mouse at 
the retention time the user wants to set to update the set 
retention time. 

Reference Ion Ratio only Apply the measurement value of the current reference ion ratio 
as the set value. 

*For GCMS only, the event number is adjusted automatically when the retention time is changed. 

3.15.3 Noise Range Setting (GCMS only) 

The start and end times of noise calculation can be selected and specified on the graph area. 
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Noise Range Setting The start and end times of noise calculation can be 
selected and specified on the graph area. 

Drag the time you want to set and update the start 
time and end time and the green bar will move. 

 

 
 
Drag from the start time to end time. 

 
 

When [Show Noise Range] is checked in Display Settings, the specified noise range and 
automatically calculated noise range can be checked on the chromatogram. 
 

 
 

3.15.4   Select Quant. Ion 

It is possible to swap a reference ion in for the quantitation ion.  Click on this context menu item to 
show a list of available reference ions.  Select the required reference ion to make it the new 
quantitation ion.  Quantitation is performed automatically. 

 

3.15.5 Manual Identification 

There are 3 ways to do Manual identification.  Manual identification can only be performed on the 
quantifier ion. 
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A) Using the context menu 

 1. Right click in a chromatogram graph area in Compound Details pane to show the 
context menu. 

 2. Select Manual Identification. This brings up a vertical bar in the chromatogram. 

 3. Move the bar by moving the mouse cursor. 

 4. Click over or near a peak to be identified. 

 5. Data gets updated for that compound in the Compound Results pane and in the 
Compound Details pane and a triangle mark appears over the apex of the nearest 
peak. 

 

B) Using the keyboard shortcut 

 1. Right click on a peak while holding the [Shift] and [Ctrl] keys down. 

 2. Data gets updated for that compound in the Compound Results pane and in the 
Compound Details pane and a triangle mark appears over the apex of the peak. 

 

C) If there are multiple peaks picked and one of them has been identified (has a triangle at its 
apex) it is possible to reassign the identification to another peak by dragging the triangle to 
the new peak. 

 1. Move the mouse on to the apex of the identified peak.  A hand cursor signifies it is 
possible to perform the change. 

 2. Click and hold down the left mouse button to “grab” the triangular mark, then drag the 
mark over to the apex of the new peak and release the mouse button to “let go” of the 
mark. 

 

 3. Data gets updated for that compound in the Compound Results pane and in the 
Compound Details pane and a triangle mark should appear over the apex of the newly 
identified peak. 

 

If the exact peak apex is not selected, the nearest peak apex will be selected as the new peak. 

Setting peak identification for a standard sample will result in a calibration point being displayed for 
the selected sample and compound. 
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3.15.6 Clear Identified Peak 

There are 2 ways of removing peak identification for a compound.  Peak identification can only be 
deleted from a quantifier ion. 

A) Using the context menu. 

 1. Right click in a chromatogram graph area in Compound Details pane to show the 
context menu. 

 2. Select ‘Clear Identified Peak’ in the context menu. 

 3. Click over an identified peak. 

 4. Data gets updated for that compound in the Compound Results pane and in the 
Compound Details pane and the arrow above the peak apex will be removed and 
there will be no peak identified for the selected compound. 

 

B) Using the keyboard shortcut. 

 1. Double right click on an identified peak while holding the [Shift] and [Ctrl] keys down. 

 2. Data gets updated for that compound in the Compound Results pane and in the 
Compound Details pane and the arrow above the peak apex will be removed and 
there will be no peak identified for the selected compound. 

 

 

3.15.7 Delete All Peaks 

Delete all peaks in the result chromatogram. 

3.15.8  Manual Peak Integrate  

If peaks cannot be detected normally by performing automated peak integration, peak integration 
can be performed manually. The following operations can be performed. 

Manual Peak Integrate 

Link Point Draws a baseline connecting two points of a chromatogram specified using 
the mouse to create a new peak. 

Horizontal Draws a horizontal baseline connecting two points specified on the x-axis 
using the mouse to create a new peak. 

New Baseline Draws a baseline connecting arbitrary 2 points by dragging the mouse. 

 

 

These operations can be accessed from the context menu displayed by right-clicking the mouse on 
a chromatogram in Compound Details. 

 

3.15.8.1 Manual Peak Integration – Adjusting existing baselines 

It is possible to modify a peak by dragging its ends to a new location. For this  

 

 

Removing a peak identification in a standard sample results in removing the corresponding 
calibration point in the calibration curve for the selected sample and compound. 
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 1. Select the chromatogram trace (bring to the top) whose peak is to be modified. 

 2. Bring the cursor over the baseline indicators marking the start or the end of a peak. As 
the cursor goes over the chromatogram at a peak baseline indicator end, it changes its 
default shape to an arrow to indicate possibility for a change. 

 

 3. While the new cursor is displayed, click and drag the mouse to a new location. Vertical 
lines show the start and end of the dragging. The new baseline is drawn that connects 
the intersection of the chromatogram at the destination of the dragging operation with 
the other end of the peak.  

 

 4. Release the mouse button to select the new location as the peak start or end position. 
Data gets updated for that compound in the Compound results pane and in the 
Compound Details pane. 

 

This procedure can be done at either end of the peak. 

 



 

3. LabSolutions Insight Functions 

95 

3.15.8.2 Manual Peak Integration – Adding a peak 

It is possible to define a new peak using either the context menu or via the keyboard shortcut.  If the 
operation is done over an existing peak, it has the same effect as replacing the old peak with the 
new one. 

A) Using the context menu. 

 1. Right click in a chromatogram graph area in Compound Details pane to show the 
context menu. 

 2. Select Manual Peak Integration followed by either Link Point, Horizontal or New 
Baseline. 

  Link Point: Draws the baseline line as a straight line connecting the two points on 
the chromatogram. 

  Horizontal: Draws the horizontal baseline from the x-values of the two points on 
the chromatogram.  The y-axis value is taken from the start point of 
the peak. 

  New Baseline Draw the baseline connecting the arbitrary 2 points. 

 3. Click on the left mouse button at the start of the new peak, then hold down and drag to 
the end of the new peak. 

 4. Release the mouse button to confirm the new peak. 

 5. Data gets updated for that compound in the Compound results pane and in the 
Compound Details pane. 

 

B) Using the keyboard shortcut. 

 1. Hold down the [Shift] key or the [Ctrl] key. 

  [Shift] key: Same effect as selecting Link Point in the context menu. 

  [Ctrl] key: Same effect as selecting Horizontal in the context menu. 

  [Alt] key: Same effect as selecting New Baseline in the context menu. 

 2. Right click with the mouse, drag the mouse and release it to mark the start and the end 
of a new peak. Vertical bars mark the start and end of the mouse drag. 

 3. Data gets updated for that compound in the Compound results pane and in the 
Compound Details pane. 

 

Below are examples showing the difference among Link Point, Horizontal and New Baseline 
options: 

 

Link Point 
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Horizontal 

  
New Baseline 

  
 

 

3.15.8.3 Apply Peak Integration to All Samples 

Apply the peak integration performed on the currently selected chromatogram to the chromatogram 
of the same compound of all samples. 

 

3.15.9 Show Spectra (GCMS only) 

Normally, chromatograms are displayed in the Compound Details pane.  For GCMS, it is possible to 
show spectra next to chromatograms.  In order to show spectra, select Spectra from the drop down 
menu of the Compound Details button.  
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The Spectrum pane is split horizontally into two.  The upper part shows the spectrum corresponding 
to the chromatogram currently displayed in the Compound Details pane.  The lower part shows the 
standard spectrum registered for the compound currently being selected.  The standard spectra are 
available in Shimadzu Method Packages and Database products.  

 

The spectrum in the upper part is averaged and subtracted in the retention time range automatically 
calculated from the peak integration result of the current chromatogram.  Spectrum Processing 
Tools can be used to obtain spectra from a specific retention time range.  The averaged rage is 
shown in blue, and the subtracted range is shown in red along the retention time axis. 

 

 

 

Right click context menu items specific or useful to this view are listed below: 

Select Select a spectrum peak for which to show the Comparison 
Chromatogram. 

The Comparison Chromatogram is added to the bottom of the 
Chromatogram Pane. 

Copy Copies the current spectrum to clipboard. 

 Picture (Enhanced 
Metafile) 

Copies the spectrum as a picture. 
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 Text Copies the spectrum as text of m/z – intensity pairs and some header 
information. 

Paste Paste the content of the clipboard onto the spectrum view. The pasted 
item can be selected and edited or deleted. 

 Picture (Enhanced 
Metafile) 

Pastes a picture on the spectrum. 

 bitmap Pastes a picture on the spectrum. 

 Unicode Text Paste the text in Unicode. 

 Text Paste the text as is. 

Export… Export the current spectrum to file in JCAMP format.  Name the file and 
save the exported JCAMP to the required location. 

Properties Configure the view settings for spectra.  

 

 

3.15.10 Show Comparison Chromatograms (GCMS only)  

It is possible to draw an XIC for the m/z of a spectrum peak obtained from the spectrum of the 
current chromatogram peak. Double clicking on the spectrum peak automatically displays the XIC.  
Up to 5 comparison chromatograms can be drawn, and they are displayed below the target 
chromatogram and reference ion chromatograms.  

 

 

3.16 [View] Calibration Curve 

To open the [Calibration Curve] pane, press the [Calibration Curve] button in the [View] menu band. 
If the [Calibration Curve] pane is not displayed when this menu button is clicked, a new pane opens. 
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3.16.1 Edit Calibration Curve 

Parameters that can be changed are underlined in properties in the calibration curve sub-window. 

 

 

Curve Fit Select the type of calibration curve to fit to the calibration points. 

 Default Use the curve type selected in the method’s quantitative parameters.  

 Linear Draw a straight line through the calibration points. 

 Point to Point Draw straight lines between each calibration point. 

 Quadratic Draw a quadratic curve through the calibration points. 

 Cubic Draw a cubic curve through the calibration points. 

 Mean RF Use the mean of the response factors to determine the slope of the 
calibration curve.  This curve always passes through the origin. 

 Exponential 

(LCMS only) 

A linear calibration curve is drawn in a natural log-natural log graph. 

Weighting Select the type of weighting to employ in calculating the fit. 

 Default Uses the weighting method selected in the method’s quantitative 
parameters.  

 None  

 1/C Weighting by the concentration. 

 1/C^2 Weighting by the square of the concentration. 

 1/A Weighting by the area (or height when height is used). 

 1/A^2 Weighting by the square of the area (or height when height is used). 

Zero Select how to handle the origin. 

 Default Use the zero through option selected in the method’s quantitative 
parameters. 

 Not Zero Forced Do not force the calibration curve through the origin. 

 Zero Forced Force the calibration curve through the origin. 

 Line to Level #1 

(GCMS only) 

 

Draw a straight line from the origin to the first calibration point regardless of 
the type of calibration curve.  The selected type of calibration curve is 
drawn from the 1st calibration point to the last calibration point. 

 

Calibration points can be excluded or included from the calibration curve. 
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Disabled calibration points are shown in grey. 

 

3.16.2 About the Calibration Curve  

Calibration involves the preparation of a set of standards containing a known amount of an analyte 
of interest, measuring the instrument response for each standard and establishing the relationship 
between the instrument response and analyte concentration in the form of a graph called calibration 
curve. Analyte concentrations in unknown samples are evaluated by using regression results 
obtained from calibration curves. 

The calibration curve models supported here are: 

• Linear  

• Quadratic 

• Cubic 

• Point to Point 

• Mean Response Factor 

• Exponential (LCMS only) 

 

The method of least squares is the technique used for fitting a polynomial (linear, quadratic and 
cubic) curve through a set of data points.  

The procedure assumes that the errors in the y values are substantially greater than the errors in 
the x values. This condition is usually true in a calibration curve in which the experimental response 
(y values) is less certain than the quantity of analyte (x values).  

A second assumption is that the uncertainties (standard deviations) in all the y values are similar. 
For the polynomial curves variations of these models can be obtained by forcing the curve through 
the (0,0) point and/or by introducing weights in the curve fit.  

The assumption in no weight least square is that each data point provides equally precise 
information for the curve fit. This favours numbers of larger value over numbers of smaller value.  

Other possibilities for weights are: 1/C where C is the concentration (does not favour high 
concentrations), 1/C2 (favours smaller concentrations), 1/A where A is the response measured as 
are or height (does not favour higher response values), and 1/A2 (favours smaller response values). 
The main advantage of weighted least squares is the ability to handle regression situations in which 
the data points are of varying quality. The correlation coefficient R2 is displayed as a measure of the 
strength of the degree of correlation between the concentration and response. A positive result 
close to 1 indicates a direct correlation. 
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In point-to-point calibration the calibration curve is a linear interpolation between any two 
consecutive calibration points.  

In mean response factor curves, a line is calculated passing through each individual point and the 
origin, then the mean of the coefficients of the slopes is calculated and used to set a line with that 
slope passing through the origin. 

Three useful statistics are calculated and displayed for the calibration data: mean response factor, 
standard deviation of the response factor and relative standard deviation of the response factor. 

In addition to the calibration curve a graph plot of the residuals from a fit can be displayed as it can 
highlight problems with the calibration data fit. Ideally, the residuals should be spread randomly 
around the zero. 

In edit mode both graphs allow calibration points to be excluded from a curve fit. The calibration 
curve graph still displays excluded points so that they can be included again should the user choose 
to do so. 

Repeated measurements per concentration are allowed and their average response used to form a 
calibration point. 

 

3.16.3 Reference Ion Calibration Curves  

Insight automatically calculates the reference ion calibration curve if the reference ion peak has 
been integrated.  Quantitation results obtained using the reference ion calibration curves are 
displayed in the results table as [Ref n conc.].  Reference ion calibration curves can be selected 
from the drop-down list at the top left of the calibration curve pane.  

The calibration curve parameters are common to target ions and reference ions. 

 

 

 

3.17 [View] Survey 

The Survey view is accessed through the [Survey] button in the View menu band. 

If the Survey pane is not already shown when this menu button is clicked, then a new pane is 
opened. 

If the Survey pane is already created, but not showing on top, clicking on this button will bring 
Survey to the top. 

If the Survey pane is showing on top, clicking on this button will close the pane. 

The purpose of the [Survey] pane is to present a grid of measured ion chromatograms.  The 
chromatograms can be shown as compounds against samples or samples against chromatograms.   

Access the Survey [Display Settings] by selecting the [Properties…] caption menu option.  Set the 
orientation of the Survey View by selecting the appropriate button in [Configure chromatogram 
panel layout:].  See 3.19.4 Survey for details on the rest of the display options for the Survey View. 
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It is also possible to select which compounds and samples to show the chromatograms for.   

 

The samples to be shown in the Survey view are specified by checking/unchecking the sample 
selection checkbox for each sample in the Sample List, Sample Results or Summary table. 

 
 

Compound View 
Sample selection checkbox is in 
the [Sample List]. 

 
 

Sample View 
Sample selection checkbox is in 
the [Sample Results] table. 

 

Summary View 
(Compounds vs Samples) 

Sample selection checkbox is in 
the header next to each sample 
name. 
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(Samples vs Compounds) 

The selection checkbox is next to 
the sample ID (#). 

 

Similarly, compounds to be shown in the Survey view are specified by checking/unchecking the 
compound selection check box for each compound in the Compound Results, Compound List or 
Summary table. 

 
 

Compound View 
Compound selection 
checkbox is in the 
Compound Results 
table. 

 
 

Sample View 
Compound selection 
checkbox is in the 
Compound List. 

 
 

Summary View 
(Compounds vs. Samples) 

Compound selection 
check box is found next 
to the Compound ID (#). 

 
 
 
 
 
 
 
 
(Samples vs. Compounds) 
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Compound selection 
checkbox is in the 
header next to each 
compound name. 

 

Filtering is applied to Lists and Results are also applied to [Survey].  Only those samples showing in 
the List or Results table are shown in Survey. 

Once samples and compounds are selected for showing in [Survey], their chromatograms are 
drawn as shown below: 

 

 

The Survey view supports chromatogram zooming functionality by means of a slider control at the 
top of the view: 

 

The level of zoom set using this control is applied to all chromatograms displayed in the Survey 
view. 

 

There is an option to show the selected compound or sample only: 
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When checked the compound selected in the [Compound List] is the only row to be shown.  

 Selecting [Show selected sample only] provides a similar result where only the selected samples 
are shown. 

When [Show selected compound only] is selected, only the compound row selected in the 
Compound List is displayed. Selecting [Show selected sample only] provides same results. 

 

Right click in a chromatogram graph to show the context menu below. 

Select the appropriate zooming operation as required. 

 

 

3.17.1 Tile Mode 

The chromatogram for each compound and sample is shown in the [Survey] view. In the Tile 
Mode, the chromatogram of multiple samples can be shown in 1 pane for the specified 

compound and can be compared with ease. In LabSolutions Insight, it is called “Tile”. 

 

In Display Settings in the [Survey] view, select [Tile Mode] in Configure chromatogram panel 

layout. Refer to 3.18［View］ -[Settings] –[3.18.3 Survey] regarding how to set. 
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In the Tile Mode, the multiple chromatogram specified in [Max traces] is shown in 1 tile. 

 

The following example shows 4 chromatogram is shown in 1 tile. 

 

4 chromatogram is shown in 1 tile. The compound name is shown on the top. The label(file 
name and color) at the upper left shows the corresponding data. 
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In the Tile mode, it is easy to confirm what data has the largest peak area when the filling 
chromatogram color is different among each data. It is recommended to set the peak fill style 
as follows. 

 

 

In Configure peak fill style, set [Translucent] and [Use trace color] and the chromatogram as 
shown in the above sample is shown as follows. 

 

 

When [Base Shift] is checked, it is easy to confirm the peak starting and end points. 

 

 

 

The manual peak integration is possible for the overlay chromatogram and available for the top 
most chromatogram. The top on the label at the left top shows the top most data. Click    to 
switch the data. When it is clicked, the top most chromatogram will be changed as follows. 
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The number of the samples shown in 1 tile can be changed by changing the parameter on the 
[Survey] view. 

 

 

 

1 tile is shown in the above example. When [Show selected compound only] is not checked, the 
tiles for all the compounds will be shown. 
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3.18 [View] QC Chart 

The [QC Chart] pane can be opened from the [QC Chart] button in the [View] menu band. If the [QC 
Chart] pane is not displayed when this menu button is clicked, a new pane opens. 

If the [QC Chart] pane has already been created but not activated, clicking this button activates [QC 
Chart]. If the button is clicked when the [QC Chart] pane is active, the pane closes. 

 

Select the graph to display in the [QC Chart] pane from the drop down list of the [QC Chart] button. 

 

 

3.18.1 Levey-Jennings chart 

In the Levey-Jennings chart, quantitative values of the compound selected on the table in each 
sample are plotted on the vertical axis and sample IDs on the horizontal axis on the graph in the 
order that they are displayed in [Sample List], [Sample Results] or [Summary]. 

 

 

Data points corresponding to the currently selected sample are displayed slightly larger than other 
data points. Samples corresponding to the data points selected on the chart are also selected on 
the table. 

When there is no corresponding quantitative value for a sample because no peak has been 
identified or for any other reason, the point is skipped and the chart becomes discontinuous. 
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The samples to be displayed in the [QC Chart] pane can be specified by selecting the checkbox in 
the [Chart] item for each sample in [Sample List], [Sample Results], or [Summary]. 

 

 

When the [Show selected compounds only] checkbox is cleared, the graphs of all compounds for 
which the checkbox for the [Chart] item is selected are displayed. At this time, data points are 
displayed only for the selected compound. The list of the displayed compound names is shown in 
the upper left area of the chart. 

 

The following quantitative values can be displayed in the [QC Chart]. 

 

 

 %Conc. Outside Curve  ISTD %Diff (Stds.) Area  Ref 1-5 Std Ratio %Diff 
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 %Dev RRT  ISTD Amount  Ref. RRT 

 %Diff  ISTD Area  RF 

 %RSD (Area)  ISTD Height  RF %RSD (curve) 

 %RSD (Conc)  ISTD RT  RF %RSD (level) 

 Accuracy (%)  ISTD RT Diff  RF Deviation 

 Actual Ret. Index  Mass Error (mDa)  RF Mean (curve) 

 Area  Mass Error (ppm)  RF Mean (level) 

 Area Ratio  Mass Error Score  RF RSE (curve) 

 Asymmetry  Noise  RF SD (curve) 

 Average Conc.  Peak End  RF SD (level) 

 Average Conc. (R1, R2)  Peak Start  RRT 

 Conc.  Quant. Limit (QL)  RT %Diff 

 Conc. (no Dil.)  Recovery  RT %Diff Score 

 Confidence  Ref 1-5 Actual Ratio  RT Diff 

 Custom Calc. Result 1 – 5  Ref 1-5 Conc.  S/N 

 Detect. Limit (DL)  Ref 1-5 Found Mz  Sample Amt. 

 Dil. Factor  Ref 1-5 Mass Error 
(mDa) 

 Score 

 Found Mz  Ref 1-5 Mass Error 
(ppm) 

 Std RT Diff 

 Found RT  Ref 1-5 Measured  Tailing F (10%) 

 Height  Ref 1-5 Noise  Tailing F. 

 Height Ratio  Ref 1-5 RRT  Width (50%) 

 ISTD %Diff (Controls)  Area  Ref 1-5 S/N   

 

3.18.2 Error Bars chart 

The Error Bars chart displays the error bar for the quantitative value of all samples for each 
compound. 
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When the [Show selected compounds only] checkbox is cleared, the graphs of all compounds for 
which the checkbox for the [Chart] item is selected are displayed. 
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3.19 [View] Settings 

Click on the [Settings] button in the [View] menu band to show the [Display Settings] dialog. 

Set each of the five types of settings as appropriate: 

 

3.19.1 General 

Configure general settings for Insight. 

 

Edit toolbar and button settings 

 Large Images Make the menu bar icons large. 

 Small Images Make the menu bar icons small. 

 Show Text Labels Tick to show text labels for each icon in the menu bar. 

Edit Table Style settings Click on each underlined item to configure the table styles.  See the 
sections on each View to see details about each table style. 

Enable sorting When sorting is enabled, clicking on the table column heading sorts 
the contents in ascending or descending order. 

Show statistics table Show the statistics table below the results table.  

Use checked rows for 
statistics calculation 

Use only the rows with the check box in the [#] column checked to 
calculate the statistics. 

Reset Layout Reset layout options to factory default. 
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Load Layout Select a saved layout and apply to the current table.  

Save Layout Save the current table style as layout. 

Export Layout Write saved layout to file.  

Import Layout Load layout from file.  
 

3.19.2 Chromatogram 

Configure settings for displaying chromatograms. 

 

 

Peak settings 

Peak Marks Show a  mark at the peak start and end times. 

Peak Baseline Show the peak baseline. 

Peak Shading Fill the identified peaks. They are filled in blue by default. 

Label settings 

Label Peak Area Show the area at the peak top. 
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Label Peak Height Show the height at the peak top. 

Label Peak RT Show the retention time at the peak top. 

Label Peak S/N Ratio Show the S/N at the peak top. 

Label Concentration on 
Identified Peak 

Show the concentration at the peak top of identified peaks. 

Reference ion settings 

Show Ref Ion Tolerance 
Range 

Show the allowable range of the reference ion on the 
chromatogram with two lines. 

Show Ref Ion Range Show the reference ion range on the top left of the 
chromatogram. 

Include % Diff between Actual 
and Set Ratio 

Show the difference between the set reference ion ratio 
and the actual reference ion ratio as a percentage. The 
value is displayed only when [Show Ref Ion Range] 
option is enabled. 

Reference Ion 1 ~ 5+ Show reference ions 1 to 5. 

General settings 

Use Relative Intensity Y-Axes Display the y-axis in %. 

Base Shift Shift the base of overlaying chromatograms upward. 

Show Expected RT Show a dotted line at the position of the specified 
retention time on the chromatogram. 

Show Internal Standard Ion Show the internal standard chromatogram in the 
Compound Details pane. 

Show Noise Range The noise start end time is shown as a green line on the 
time axis. 

Hide Saturation Do not use red coloured chromatogram peak. 

Show Peak Integration Tools Show the peak integration tools on Compound Details 
pane and Survey Pane. 

Show Product Ion 
Chromatograms 

Show the product ion scan chromatogram in a similar 
way to target and reference ion chromatograms.  

 

Configure Display Colors Change the color used to display the chromatogram. 



 

3. LabSolutions Insight Functions 

116 

 

Configure peak fill style Specify the transparency to fill the chromatogram. 

Solid Filled with color with no transparency 

Translucent Filled with color with transparency 

Fill Style 

Use single 
color 

Fill all chromatograms with the same 
color. The color specified in [Identified 
Peak Fill Color] is used in the Display 
Settings. 

Use 
manual 
color 

Fill the manual integrated 
chromatogram with another color. In 
Display Settings, the color specified in 
[Manual Peak Fill Color] is used for 
the manually integrated 
chromatogram. 

Use trace 
color 

Fill with the same color as the color of 
the line that shows the 
chromatogram. For the line color of 
the chromatogram, the color specified 
in [Trace 1 to 6 Color] is used in 
Display Settings. 

 

Configure chromatogram 
panel layout 

Specify the direction to place the chromatograms in the 
Compound Details pane. 

Configure chromatogram 
layout 

Specify either to overlay chromatograms or place them 
side by side in the Compound Details pane. 
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3.19.3 Spectrum (GCMS only) 

Configure settings for spectra shown in Compound Details for GCMS. 

 

 

The settings are described below.  Items that are already described for Chromatogram settings are 
omitted: 

Label settings 

Show Spectrum Labels Display labels against spectrum peaks. 

Reduce Spectrum Labels 
Density 

Reduce the number of labels when there are many 
peaks in a particular area. 

General settings 

Mirror Spectrum Plot comparison spectrum mirrored against the 
target spectrum. 

Show Scan Number Show the scan number at the top left of the 
spectrum. 

Hide Saturation Do not change saturated peak colour to red. 

Spectrum Glow Highlight spectrum peak that is recognised as being 
pointed at by the mouse cursor. 

Other settings 

Relative Label Threshold Peaks whose relative intensities, with respect to the 
tallest peak in the spectrum, exceed this threshold 
will be labelled. 
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Nominal Mass Precision (0-2 
digits) 

Configure the number of decimal places to be used 
for the peak labels.  The number of decimal places 
can be 0, 1 or 2. 

Relative Intensity Threshold Peaks whose relative intensities, with respect to the 
tallest peak in the spectrum, are below this threshold 
will not be shown. 

Absolute Intensity Threshold Peaks whose intensities are less than this threshold 
will not be shown. 

Fix m/z Range Turning this option ON will set the m/z axis range for 
the spectrum to what is specified in the two edit 
boxes. 

Enter the start m/z and end m/z for the axis range. 

 

3.19.4 Survey 

Configure settings for the survey view. 

 

 

Explanation is omitted for settings that are common for chromatogram settings. 
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Wrap Rows Specify either to display chromatograms in multiple 
rows dividing them at the right end of the screen or 
display them in a single row with a horizontal scroll bar 
in the Survey pane. 

Configure chromatogram 
panel layout 

Specify the item to be displayed on the vertical and 
horizontal directions in the Survey pane. 

 Tile Mode：The chromatogram is shown in the Tile 

Mode. For details, see 3.16.1. Tile Mode. 

 Sample-compound: Samples are displayed in the 
vertical direction and compounds in the horizontal 
direction. 

 Compound-sample: Compounds are displayed in the 
vertical direction and samples in the horizontal 
direction. 

Show samples Specify how the samples to be displayed in the Survey 
pane are narrowed down. 

 All: All samples are displayed. 

 Filtered and Flagged: Samples extracted by a filter 
and flagged samples are displayed. 

 Filtered only: Only samples extracted by a filter are 
displayed. 

Sample identifier Select the characters to be displayed on the title of the 
Survey pane. 

Specify the data file name, sample name, or sample 
ID. 

 

3.19.5 Calibration Curve 

Configure settings for the calibration curve view. 
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Display Average Calibration 
Points 

Show the average point of the calibration points of 
the same level. 

Display Repeated Calibration 
Points 

Show all calibration points of the same level. 

Display Control Points Show the points from the control sample on the 
calibration curve. 

Restrict Control Points to the 
Calibration Range 

Only show control points that fall within the 
calibration range.  Check the Display Control Points 
check box above to make full use of this 
functionality. 

Display Excluded Calibration 
Points 

Show excluded calibration points in gray. 

Include Residual Plot Show a residual plot below the calibration curve. 

Display Crosshair Show the auxiliary line for the currently selected 
sample on the calibration curve. 

Display Statistics Show the average RF, SD RF, and %RSD on the 
calibration curve. 

Calibration point (average) 
Select a marker type, size and color.  To set the 
color, click on the colored rectangle to show a palette 
to select a color from. 

Calibration point (repeat) 

Control 

Crosshair color Select the color of the crosshair.  Click on the 
colored rectangle to show a palette to select a color 
from. 
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3.19.6 QC Chart 

Configure settings for the QC Chart view. 

  

 

Display Data Point Lines Show neighboring data points connected with a line. 

Label X Axis by Acquired 
Date 

Display the x-axis by the acquisition date of each data 
item. 

Data point line Click on Colors to show the color selector for each 
compound: 
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Click on the colored rectangles to show a palette to 
select a color from. 

Mean line Select a color for the mean line. 

Click on the colored rectangles to show a palette to 
select a color from. 

1 SD line Select a color for 1 standard deviation (SD) line. 

Click on the colored rectangles to show a palette to 
select a color from. 

2 SD line Select a color for 2 standard deviations (SD) line. 

Click on the colored rectangles to show a palette to 
select a color from. 

3 SD line Select a color for 3 standard deviations (SD) line. 

Click on the colored rectangles to show a palette to 
select a color from. 

Error bar line Select a color for the error bar line. 

Click on the colored rectangles to show a palette to 
select a color from. 

Standards 

Select a marker type, size and color.  Click on the 
colored rectangle to show a palette to select a color 
from. 

Controls 

Unknowns 

All other sample types 

Error bars Select a marker type, size and color.  Color can be 
selected for each compound in the same way as the 
Data Point Line described above. 
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3.19.7 Saving and Loading Layouts  

It is possible to save table styles as a layout template.  It is also possible to write the layout to file and 
to import from an exported layout so that the same layout can be shared across all systems.  

 

⚫ Save Layout (internal)  

Save the current layout.  Click on the Save button and enter a name for the layout.  

⚫ Load Layout (internal)  

Select a saved layout and load.  Click on the Open button and select a layout from a list of 
saved layouts.  

⚫ Delete Layout (internal)  

Select a saved layout and delete. 

⚫ Export Layout (to file)  

Output saved layout to file.  Click on the Export button and select a layout to export, then 
enter a file name.  The layout can be written to a folder of choice as an Insight Browser 
Layout (*.ibl) file.  

⚫ Import Layout (from file)  

Load layout from a Layout file.  Click on the Import button and select an Insight Browser 
Layout (*.ibl) file.  In order to apply the imported layout, it is necessary to then Load the 
imported layout.  
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3.20 [View] Audit Trail 

Insight can record changes made to projects.  

3.20.1 Audit Trail Settings 

Audit trail can be set in both Data mode and Processing mode for the current files. 

In Processing mode, the Audit Trail Settings apply to processing files.  If the current data set was 
opened without using a processing file, then the Audit Trail Settings below will apply when the data 
set is first saved as a processing file. 

Click on the [Audit Trail] menu button to show the settings window. 

 

Check the [Save change history in the file] check box to enable audit trail.   

The following warning message is displayed. 

 

Click on [Yes] to enable audit trail. 

Once audit trail is enabled, select whether to be prompted to input reasons for any changes made. 

Click on the  button to confirm the settings. 

 

 

3.20.2 Entering the Reason for Change 

If [Input reason when saving file] was selected in the Audit Trail Settings window, then Insight will 
prompt for a reason when saving. 

 

 

Once the [Save change history in the file] check box is ticked, it cannot be unticked.  However, 
whether to input a reason when saving can be changed at any time. 



 

3. LabSolutions Insight Functions 

126 

 

The reason given here can be seen in the [Reason for the Change] field in the Audit Trail Log. 

In Data mode, Insight will not prompt for reasons if only flag settings or compound selection have 
changed. 

3.20.3 Viewing the Audit Trail Log in Data Mode 

In Data Mode, the audit trail log can be viewed in LabSolutions LCMS or GCMSsolution. 

Open the relevant file in LabSolutions LCMS or GCMSsolution Postrun and select [Show Audit 
Trail Log…] from the [File] menu. 

         Refer to the LabSolutions LCMS and GCMSsolution instruction manuals for details.  
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3.20.4 Viewing the Audit Trail Login Processing Mode 

Once audit trail is enabled, clicking on the [Audit Trail] menu button will display the audit trail log. 

 

Click on the [Audit Trail Settings] button to display the Audit Trail Settings window again. 

Whether to input reason for changes made to the project can be changed, but whether to perform 
audit trail at all cannot be changed. 



 

3. LabSolutions Insight Functions 

128 

3.21  [Edit] Edit Method 

Click on the Edit Method button in the Edit menu band to show the Edit Method window. 

The behaviour differs depending on whether GCMS or LabSolutions data is being used. 

 

 

3.21.1 GCMS parameters 

In Insight GCMS, the Quantitative dialog similar to GCMSsolution appears.  

 

 

 

Insight only supports Internal Standard, External Standard or Standard Addition for the 
Quantitative Method settings, even though other selections are possible . 

Hint 
If the method editor is "Read Only" but it is required that the method is edited, please 
check the following: 

 

⚫ User rights 

➢ Make sure you have the right to edit methods 

⚫ Windows functionality 

➢ Make sure the method file is not set to Read Only using the Windows File 
Explorer 

➢ Make sure the method file is not saved in a region on the PC with access 
restriction 

➢ Make sure you are logged in to Windows as a user with editing rights 

➢ Make sure there are no other applications using the method file 

⚫ Insight functionality 

➢ Remove any samples in the sample list that says "Not available" 

➢ You cannot edit GCMS semi-quantitation methods 

➢ Processing file may have failed to open correctly.  Please restart Insight and 
open the processing file in question again 
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See GCMSsolution instruction manual or online manual on how to set each parameter. 

 

After Quantitative Parameters are modified, Insight will automatically perform quantitative 
calculations on all samples and compounds.  However, Insight will not perform peak integration 
operations even if peak integration and identification parameters are changed.  In order to 
apply these changes to the results, choose one of the Integrate options: Integrate Compound, 
Integrate Sample or Integrate Batch. 
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3.21.2 LCMS parameters 

 In Insight LCMS, the Quantitative dialog similar to LabSolutions LCMS appears. 

 

See LabSolutions LCMS instruction manual or online manual on how to set each parameter. 

 

 

 

In Insight LCMS, integration and quantitative calculation are automatically performed for all samples 
and compounds when the method setting window is closed. To keep the manual peak integration 
results, select [Keep Manual Integration] from the drop down list shown below. To delete all manual 
peak integration results and overwrite them with the automatic peak integration results, select [Clear 
Manual Integration]. 

 

 

 

For LCMS-2020 methods, the Group column in the Event Details dialog opened from the 
Compound tab in the Method Editor shows the segment and the event numbers combined. 
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Keep Manual Integration Manual peak integration results will be kept 
without any modification. 

 

Clear Manual Integration All manual peak integration results will be 
overwritten with automatic peak integration 
results. 

 

 

 

3.21.3 Compound Table 

Some of the parameters in the compound table can be edited in the [Compounds] tab. 

Hint 
 

 
 
When a compound is set to use individual parameter settings, rather than the default settings, a 

marker ( ) is shown in front of the compound. 
 
In order to make all compounds use the default parameters, select “Default” then click on the 
underlined “Use default for all compounds”. 
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See GCMSsolution or LabSolutions LCMS instruction manual or online manual on the detail of 
each parameter. 

 
 

 

3.21.4 Compound Group 

The grouping parameters can be edited in the [Groups] tab. 

 
See GCMSsolution or LabSolutions LCMS instruction manual or online manual on the detail of 
each parameter. 

 
The quantitative results for the compound group added here are added to the end of Compound 
List or Compound Result. 
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When the compound group is selected on the table, the quantitation result and the calibration 

curve (only for Group Calibration) and the chromatogram is blank. Also, the quantitation result is 

limited to values that can be calculated as the result of the group. (Concentration, Area, etc.) 

 

The quantitation result of the compound group can be exported as well as the quantitation result 

of the compounds. 
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3.21.5 Custom Parameters (LCMS Only) 

The custom parameter can be edited in the [Custom Parameters] tab. This is available for 
LCMS only. 

 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

The results calculated according to the calculation formula entered here can be shown in the 

quantitation result (Compound and Sample) and the Summary view. The calculation formula is 

described by a combination of a character string indicating a preset constant and several 

operators. When an undefined character string is used, or when an operator that is not 

available is used, if an expression does not hold as an expression, an appropriate value will 

not be calculated. 

 

The calculation formula is described in the following format. 
 

 Quantitative Result 

Retention time RetTime 

Area Area 

Height Height 

Concentration Conc 

Standard 
Concentration 

StdConc 

 

 

Although Group Quantitation using Internal Standards is supported for GCMS data in Insight, 
GCMSsolution does not support this method of quantitation. 

Please DO NOT open data that has been quantitated using Group Quantitation with Internal 
Standards in Data Mode in GCMSsolution. 
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Compound Table 
Retention Time 

RetTimeCompTable 

ISTD Compound’s 
Retention Time 

RetTimeISTD 

ISTD Compound’s 
Compound Table 
Retention Time 

RetTimeCompTableISTD 

 
 

 Constant 

Constant A A 

Constant B B 

Constant C C 

 Operator 

Addition + 

Subtraction - 

Multiplication * 

Division / （It does not calculate when the 

denominator is 0） 

Power e （Only integers can be specified for the 

exponent part） 

 Parenthesis 

Parentheses () allows you to define the order of calculation. 

 Special function 

Square root sqrt() 

3.21.6 Spectrum (LCMS Only) 

Spectrum processing parameters can be configured in the Spectrum tab.  This feature is only 
available for LCMS. 

Spectrum processing parameters are used for calculating spectra under the processed 
chromatogram peaks.  Please refer to the LabSolutions user manual for details on the meaning of 
the parameters. 

3.22 [Edit] Integrate Batch 

Select Integrate Batch from the Edit menu band to perform automated peak integration and 
quantitative calculations on all compounds in all samples. 

Flags and filters will be reassigned and reapplied as appropriate. 

This operation cannot be carried out by a user who does not have edit rights. 

This operation cannot be carried out if any of the data files are read-only.  
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When [Integrate Batch] is applied for GCMS data, the following message will 
appear. 

 

When [Yes] is selected, the manual peak integration result will be deleted and automatic 
peak integration will be performed. When [No] or [Cancel] is selected, it will not be 
deleted aborting the automatic peak integration. 
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3.23 [Edit] Integrate Sample 

When [Integrate Sample] in the [Edit] menu band is selected, the automatic peak integration 
and quantitative calculation are performed for all compounds of the currently selected sample. 

When the sample type of the selected sample is Standard, the calibration curves for all 
compounds are recalculated and all sample results are updated. The flagging and filtering will 
be applied again.  

Users without editing privileges cannot perform this operation. Also, this operation cannot be 
performed when one of the data files is read-only. 

When [Integrate Sample] is applied to GCMS data, the message confirming deleting the 
manual peak integration result will appear like [Integrate Batch]. 

 

3.24 [Edit] Integrate Compound 

When [Integrate Compound] in the [Edit] menu band is selected, the automatic peak integration 
and quantitative calculation are performed for the selected compounds of the currently selected 
sample. 

When the sample type of the selected sample is Standard, the calibration curves for all 
compounds are recalculated and all sample results are updated. The flagging and filtering will 
be applied again.  

Users without editing privileges cannot perform this operation. Also, this operation cannot be 
performed when one of the data files is read-only. 

When [Integrate Compound] is applied to GCMS data, the message confirming deleting the 
manual peak integration result will appear like [Integrate Batch] 

 

3.25 [Edit] Integrate Result 

When [Integrate Result] in the [Edit] menu band is selected, the automatic peak integration and 
quantitative calculation are performed for the selected sample of the currently selected 
compound. 

When the sample type of the selected sample is Standard, the calibration curves for all 
compounds are recalculated and all sample results are updated. The flagging and filtering will 
be applied again.  

Users without editing privileges cannot perform this operation. Also, this operation cannot be 
performed when one of the data files is read-only. 

When [Integrate Result] is applied to GCMS data, the message confirming deleting the manual 
peak integration result will appear like [Integrate Batch]. 
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3.26 [Edit] Edit Tables 

Edit Tables mode can be invoked by clicking on the Edit Tables button in the Edit menu band.  
When the Edit Table button is turned ON (turned dark blue) the Edit Tables mode is activated.  
Clicking on the Edit Tables button again turns it off (turns light blue) 

 

Sample levels and/or sample types in the Sample List or Sample Results can be edited in Edit 
Tables mode.  

Right click on the item that needs to be changed and display the Edit context menu. 

 

Alternatively, double click in the field to be edited. 

A drop down list is shown using either method. 

 

Select the sample type to change to. 

The sample level, retention time and Ref1-5 Set Ratio can be set in a similar way. 

 

The pencil mark shown below is shown for items that can be edited. 
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3.26.1 Update RT and Ion Ratios 

In the Edit Tables mode, the set values for the retention time and reference ion ratio can be 
changed based on the measured values. 

Using the [Update RT and Ion Ratios] menu, the measured value of a single sample can be simply 
copied or the average of the measured value of multiple samples can be used as the set value. 

 
1. To use the measured value of a single sample as the set value 

Turn ON the Edit Tables mode, select a single sample in [Sample List], [Sample Results], or 
[Summary], right-click the mouse, and then click [Update RT and Ion Ratios]. 

 

The [Update RT and Ion Ratios] window is displayed. 

 

If the user selects a single sample and selects the menu from the right-click menu, [Apply an 
average value to all compounds calculated from the 1 sample(s);] is displayed as shown above. In 
this case, [Found Ret. Time] and [Ref 1-5 Actual Ratio] of the currently selected sample are simply 
copied to [Ret. Time] and [Ref 1-5 Set Ratio]. 

 

Update Retention Time and Ion 
Ratios*  

Change [Ret. Time] and [Ref 1-5 Set Ratio]. 

Update Retention Time only* Change [Ret. time]. 

Update Ion Ratios only Change [Ref 1-5 Set Ratio]. 

* For GCMS only, the event number is adjusted automatically when the retention time is changed. 

  

ZStanius
Highlight

ZStanius
Typewriter
1.6.2
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2. To use the average of the measured value of multiple samples as the set value 

Highlight multiple samples and select [Update RT and Ion Ratios] from the right click menu. 

 

 

 

If the user selects multiple samples and selects the menu from the right-click menu, [Apply an 
averaged value to all compounds calculated from the ## sample(s):] is displayed as shown above. 
In this case, the average value of [Found Ret. Time] and [Ref 1-5 Actual Ratio] of the selected 
samples is set for [Ret. Time] and [Ref 1-5 Set Ratio]. 

On exiting the Edit Tables mode, the calibration curve(s) will be updated as necessary and 
quantitation results updated.  

Closing current files and exiting the application cannot be done whilst in the Edit Tables mode. 

 

Select Yes to exit Edit Tables mode to perform other operation. 

Select No or Cancel to stay in Edit Tables mode and continue editing the tables. 
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3.27 [Edit] Edit Flags 

Select Edit Flags from the Edit menu band to launch the Edit Method Settings – Flags dialog.  Flag 
criteria can be set here. 

 

 

 

When Group Quantitation is being used, a small triangle will be shown next to the Flags button.  
Clicking on this button will show a drop down list to select between compounds and groups. 

 

 

3.27.1 Setting flag groups 

Click on the +/- tab to add new flag groups. The flags are not applied to ISTD. 
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The available flag groups are: 

Unknown Flags set in this group only apply to Unknown sample types. 

Standard Flags set in this group only apply to Standard sample types. 

Control Flags set in this group only apply to Control sample types. 

Spiked Flags set in this group only apply to Spiked sample types. 

Unspiked Flags set in this group only apply to Unspiked sample types. 

water Flags set in this group only apply to blank samples that have been 
identified as “water”.  This blank type is available by default. 

solvent Flags set in this group only apply to blank samples that have been 
identified as “solvent”.  This blank type is available by default. 

matrix Flags set in this group only apply to blank samples that have been 
identified as “matrix”.  This blank type is available by default. 

 

Check the appropriate flag group to show the flag criteria table for the flag group, or uncheck the 
boxes to hide the flag groups.  Right click context menu is available to set or unset flag groups all at 
once: 

Select All Highlight all items. 

 

When a new sample type tab is added it will contain a flags table containing the read only 
compound identification columns and an Edit flags button.  The compound identification columns 
are: 

# Row number. 

Compound Compound name. 

m/z m/z of the compound, or for MRM experiments, the MRM transition for the 
compound. 

RT Retention time of the compound. 
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3.27.2 Setting flags 

Click on the Edit button to add and remove flag criteria columns. 

 

 

Check the boxes for the flags required and press OK. 

  

Any deselected flags will be removed from the flag table and any newly selected flags will be added 
to the flag table.  Newly added flags will be displayed with no values set.  If a flag is deselected and 
then reselected then it is displayed with its previously set value.  Flags can be selected or 
unselected all at once using the right click context menu: 

Select All Highlight all items. 
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The flags that can be selected depend on the flag group. Please see 2.6.3 Flag ID for details. 

 

3.27.2.1 Setting flag criteria 

Each flag criterion can be typed in directly or set using the right click context menu items: 

Clear Clears the current cell value. 

Fill Down Sets the value of all rows of this flag type below this row to this row’s value. 

Use Default Uses the flag’s default value for this cell value. 

Use Default (All Rows) Sets the value of all rows of this flag column to the default value. 

 

Default values are shown in different color text to custom values. 

If an invalid value is entered in the flag criteria, it is highlighted using a red “!” mark.  Hover the 
mouse pointer over the red “!” mark to get a tooltip that explains the reason for the “!”.  The problem 
must be corrected before any other fields can be edited. 

 

 

 

 

3.27.3 Flag Results 

A combination of flags can be used as criteria for obtaining flagged results. 

Click on the Result button at the top right of the Flag Editor. 

Hint 

Since there are many flags, it may be a challenge to find the one that is needed. 

 

Use the filter button at the top right to help find the required flag. 

Please refer to Section 3.11.1 for details. 

Hint 

Highlight multiple rows in the flag criteria to copy and paste. 

 

 



 

3. LabSolutions Insight Functions 

146 

 

The results can be labelled Pass, Fail or Inconclusive using a combination of the flags. 

 

Flags List of flags currently in use. 

 

Fail When flags selected here apply, the result will be labelled “Fail”. 

Clicking on “All Flagged” and “Any Flagged” will toggle between the two. 
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Inconclusive When flags selected here apply, the result will be labelled “Inconclusive”. 

Clicking on “All Flagged” and “Any Flagged” will toggle between the two. 

 

Pass custom text Results that are neither Fail nor Inconclusive are labelled “Pass” by default.  
Tick this option and enter a custom text to show in place of “Pass”. 

 

Inconclusive custom 
text 

Tick this option and enter a custom text to show in place of “Inconclusive”. 

 

Fail custom text Tick this option and enter a custom text to show in place of “Fail”. 

 

Show result color bars Show color bars in the Flag Result column. 

 

The colors can be configured in Application Configuration. 

Please see Section 1.15 for details. 

 

3.28 [Edit] Select Compounds 

Selected compounds can be hidden. 

Select [Select Compounds] in the [Edit] menu band to display the [Select Compounds] window. 

           
 
The [Shown compounds] list displays all compounds that are currently visible in the [Compound 
List], [Compound Results] or [Summary].   
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Select compounds that should not be visible in the [Compound List], [Compound Results] or 

[Summary] and click on the  button to move the compounds to the [Not shown compounds] 
list. 

Similarly, select compounds in the [Not shown compounds] list and click on the  button to 
move the compounds to the [Shown compounds list. 

Click on the  button to reflect the changes to the [Compound List], 
[Compound Results] or [Summary]. 

 
3.29 [Review] Review Status  

Review Status is set for each compound contained in samples. Setting the Status enables recording 
of the status of processes for all analysis targets. In Data mode, the status is saved in the DAMLP 
file.  In Processing mode, the status is saved in the processing file. 

  

Status is registered to the table of all Compound, Sample, and Summary Views. The [Status] 
column can be enabled from the [Table Style] configuration dialog. 

 

[●Pending] is preset for all statuses. The following statuses can be set. 

●Pending Indicates that the respective quantitative result is in the [Pending] 
status. 

●Accept Indicates that the respective quantitative result is in the [Accept] 
status. 

●Rerun Indicates that the respective quantitative result is in the [Rerun] 
status. 

●Review Indicates that both [Pending] and [Accept] are included in the 
status of the compounds contained in the target sample or 
samples containing the target compound. 
 
Note: It indicates that the [Accept] process is being carried out or 
that the [Pending] status is intentionally maintained. 

●Accepted Indicates that the [Accept] status of the standard sample has been 
sent. 

●Rerun Complete Indicates that the [Rerun] status has been sent. 

●Sent Indicates that the [Accept] status has been sent. (Except for 
standard samples) 

●Complete Indicates that [Sent] or [Accepted] process has been completed for 
the status of all compounds contained in the target sample or the 
status of all samples containing the target compound. 

 

 

Review status cannot be set for compounds in internal standard substances (ISTD). 
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3.29.1 [Review] Accept 

Click the [Accept] button in the [Review] menu band to change the status of the currently selected 

quantitative result to [●Accept] 

 When the Compound View is displayed, the status of the compound currently selected on 

[Compound Results] is changed. After the change, the next compound whose status is [●
Pending] is selected.  

 When the Sample View is displayed, the status of the sample currently selected on [Sample 

Results] is changed. After the change, the next sample whose status is [●Pending] is 

selected. 

 When the Summary View is displayed, the status of the sample (compound) currently selected 

on [Summary] is changed. After the change, the next sample (compound) whose status is [●
Pending] is selected. 

  

The status can be changed by the procedures below as well as by using the [Accept] button in the 
[Review] menu band. 

 When Compound View is displayed, right-click the mouse on [Compound Results] and select 
[Accept]. 

 When Sample View is displayed, right-click the mouse on [Sample Results] and select 
[Accept]. 

 When Summary View is displayed, right-click the mouse on [Summary] and select [Accept]. 

 

 Use the keyboard shortcut. 

 Press the [A] key, for “Accept”, on the keyboard.  

 

When all compounds for a sample are either [●Pending] of [●Accept], the sample in the [Sample 

List] is marked as [●Review].  When all samples for a particular compound are either [●Pending] 

or [●Accept], the compound in the [Compound List] is marked as [●Review]. 

  

 

The status of standard type samples cannot be set to [●Rerun]. 
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3.29.2 [Review] Rerun 

Click the [Rerun] button in the [Review] menu band to change the status of the currently selected 

quantitative result to [●Rerun]. 

 When Compound View is displayed, the status of the compound currently selected on 

[Compound Results] is changed. After the change, the next compound whose status is [●
Pending] is selected. 

 When Sample View is displayed, the status of the sample currently selected on [Sample 

Results] is changed. After the change, the next sample whose status is [●Pending] is 

selected. 

 When Summary View is displayed, the status of the sample (compound) currently selected on 

[Summary] is changed. After the change, the next sample (compound) whose status is [●
Pending] is selected. 

 

The status can be changed by the procedures below as well as by using the [Rerun] button in the 
[Review] menu band. 

 When Compound View is displayed, right-click the mouse on [Compound Results] and select 
[Rerun]. 

 When Sample View is displayed, right-click the mouse on [Sample Results] and select [Rerun]. 

 When Summary View is displayed, right-click the mouse on [Summary] and select [Rerun]. 

 

 Use the keyboard shortcut. 

 Press the [R] key for “Rerun” on the keyboard.  

 

 

The status of all compounds in a sample can be changed by right clicking 
on a sample in the [Sample List]. The status of all compounds in 
[Compound Results] changes at once. 
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If there is at least one [●Rerun] compound in a sample, the sample is marked as [●Rerun] in the 

[Sample List].  If there is at least one [●Rerun] sample for a particular compound, the compound is 

marked as [●Rerun] in the [Compound List]. 

 

3.29.3 [Review] Pending 

Click the [Pending] button in the [Review] menu band to change the status of the currently selected 

quantitative result to [●Pending]. 

 When Compound View is displayed, the status of the compound currently selected on 
[Compound Results] is changed. Clicking the [Pending] button does not change the selected 
target. 

  When Sample View is displayed, the status of the sample currently selected on [Sample 
Results] is changed. Clicking the [Pending] button does not change the selected target. 

  When Summary View is displayed, the status of the sample (compound) currently selected on 
[Summary] is changed. Clicking the [Pending] button does not change the selected target. 

 

The status can be changed by the procedures below as well as by using the [Pending] button in the 
[Review] menu band. 

 When Compound View is displayed, right-click the mouse on [Compound Results] and select 
[Pending]. 

 When Sample View is displayed, right-click the mouse on [Sample Results] and select 
[Pending]. 

 When Summary View is displayed, right-click the mouse on [Summary] and select [Pending]. 

 

Note: There is no keyboard shortcut for this function. 

 

3.29.4 [Review] Send 

Clicking the [Send] button in the [Review] menu band changes the currently set status to indicate 
that the [Send] process has been completed. The status is also saved in the DAMLP file for Data 
mode and processing file for Processing mode. 

 

Clicking the [Send] button changes the statuses as shown below. 
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●Accept （except for STD）  ●Sent 

●Accept （STD）  ●Accepted 

●Rerun  ●Rerun Complete 

 

When the [●Sent] or [●Accept] process is completed for the status of all compounds contained in 

the target sample or the status of all samples containing the target compound, the status of the 

sample becomes [●Complete]. 

 

 

  

 

The Status can be changed using the keyboard shortcut. 

[A]: Change to [Accepted] and move to the next [Pending] sample. 

[R]: Change to [Rerun] and move to the next [Pending] sample. 

[P]: Move to the previous [Pending] sample. 

[N]: Move to the next [Pending] sample. 

 



 

3. LabSolutions Insight Functions 

153 

 

3.30 [Report] Reports 

When [Reports] is clicked in the [Report] menu band, the report templates set in Application 
Configuration are shown in the drop-down list. 

  

The report formats can be configured using the Report Configuration application.  Please refer to 
the Report Configuration user manual for details. 

3.30.1 Report options 

Depending on the “Locked” status of the selected template, the following dialog appears. For details 
of the report options, see 1.17 Report template management. 

 

When Locked When not Locked 
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3.30.2 Print preview 

Click on the button to show the print preview.  The print layout and content can be previewed 
and Page Setup and Print Settings (printer) can be adjusted before choosing to send as a print job. 

 

 

 

Select the page number to show in the preview. 
 

 

Select the level of zooming of the preview. 
 

 

Select the number of pages to show side by side in the preview. 
 

 

Open the [Page Setup] dialog for the default printer. 

 

Open the [Print Settings] dialog for the default printer. 

 

Print to the default printer. 

 

Show the previous page. 

 

Show the next page. 

 

Cancel print preview. 
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3.30.3 Basic format of chromatograms with Reference Ions 
options 

Retention time and area (or height) values are printed on the top of a chromatogram. If these labels 
are turned off in Display Settings, then they will be printed outside of the data view rectangle (as 
shown below). 

Ion Ratio is displayed above the graphs.  If the Ion Ratio is out of range, then an asterisk is added. 

Stack Overlay 

 

 

 

3.30.4 General report layout 

When all contents are to be reported, at the top of the report is a result table. Chromatograms of 
each compound for all samples are shown below the table. 

When reporting per compound, each chromatogram for the compound in a sample is placed next to 
each other under the title line for the compound.  Line feeds are used when there are too many 
chromatograms.  After all chromatograms for a compound are displayed another line feed (end of 
paragraph) is issued and next compound title is written followed by the chromatograms for each 
sample.  When reporting per sample, the same principle applies, except that now, compound 
chromatograms are reported per sample. 

Data Filenames are printed without path or extension. 
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3.31  [Report] Report 

This function is available when GCMSsolution or LabSolutions LCMS is installed and [Data Mode] is 
slected. 

It is also not available in Processing mode. 

If a report format file is specified in a batch table before sample acquisition, the result of the data file 
can be printed in LabSolutions Insight. 

Click on the Report button in the Report menu band to print a GCMSsolution or LabSolutions report.  
The report can be printed from the right click context menu in the following locations: 

There is no intermediate dialog to choose any settings.  The report will be sent to the default printer 
to be printed, immediately. 

 

 

3.32 User Rights 

What operations can be carried out depends on the user rights.  Below is a table summarizing the 
relationship between LabSolutions user rights, Insight user rights and Insight operations. 

 Read Only Edit Result Edit Method Part Read Write 

LabSolutions Right  None Perform Postrun 
Analysis 

Perform Postrun 
Analysis & Edit 
Method(RT and Conc) 

Perform Postrun 
Analysis & Edit 
Method(data 
processing 
parameters) 

Insight Features Limitations 

Open Yes Yes Yes Yes 

Wizard No Yes Yes Yes 

Wizard – Create Method No No No Yes 

Update No No No Yes 

Load Method No No No Yes 

 Hint 

Compounds and samples that have been filtered out in the main Insight view are not included 
on the report. 

Hint 

If GCMSsolution or LabSolutions report is printed without saving files, analysis result is not 
reflected in the printed report. Be sure to save analysis result before printing.  

 

If a PDF creator or other converter program is configured as the default printer, its dialogs can 
get hidden behind Insight.  Use [Alt] + [Tab] key strokes to bring the relevant window to the 
top. 

ZStanius
Highlight

ZStanius
Typewriter
1.6.2
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Load Flags No Yes Yes Yes 

Import No Yes Yes Yes 

Save No Yes Yes Yes 

Save As  No No Yes Yes 

Save Flags No Yes Yes Yes 

Export (Text) Yes Yes Yes Yes 

Export (Method) No No No Yes 

Close Yes Yes Yes Yes 

Edit Method Yes Yes Yes Yes 

Edit Method  

- Except for  

Compound Tab No No No Yes 

Edit Method 

- Compound Table No No No Yes 

Edit Method 

- Compound Table  

(Std. Conc.) No No Yes Yes 

Integrate Batch No Yes Yes Yes 

Integrate Sample No Yes Yes Yes 

Integrate Compound No Yes Yes Yes 

Integrate Result No Yes Yes Yes 

Integrate Batch 

- Integration No No No Yes 

Integrate Sample 

- Integration No No No No 

Integrate Compound 

- Integrate No No No Yes 

Integrate Result 

-  Integrate No No No No 

Edit Table No Yes Yes Yes 

Edit Table > Sample 
Name No Yes Yes Yes 

Edit Table > Sample ID No  Yes Yes Yes 

Edit Table > Sample Amt. No Yes Yes Yes 

Edit Table > Dil. Factor No Yes Yes Yes 

Edit Table > Sample Type No No No Yes 

Edit Table > Level No No No Yes 

Edit Table > m/z No No No Yes 

Edit Table > Ref 1~5 m/z No No No Yes 

Edit Table > RT No No Yes Yes 
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Edit Table > Update RT 
and Ref. Ions No No Yes Yes 

Remove Data No Yes Yes Yes 

Delete Result No Yes Yes Yes 

Review No Yes Yes Yes 

Chromatogram > Update 
RT and Ref. Ions No No Yes Yes 

Chromatogram > Select 
Quant Ion No No No Yes 

Chromatogram > Manual 
Identification No Yes Yes Yes 

Chromatogram > Clear 
Identified Peak No Yes Yes Yes 

Chromatogram > Delete 
All Peaks No Yes Yes Yes 

Chromatogram > Manual 
Peak Integration No Yes Yes Yes 

Calibration Point - Include 
/ Exclude No No No Yes 

Calibration Pane - 
Calibration Parameters No No No Yes 

Edit Flags No Yes Yes Yes 

Show Compounds No Yes Yes Yes 

Print Report Yes Yes Yes Yes 

 

ZStanius
Highlight

ZStanius
Typewriter
1.6.2

ZStanius
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ZStanius
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4 Installation and Uninstallation 

4 Installation and Uninstallation 

This section describes how to prepare Insight for use, and how to terminate its usage. 

4.1 Installation 

To install the LabSolutions Insight software, run Setup.exe in the installation disk. 

 

Follow the onscreen prompts to install LabSolutions Insight software.  

Select the operation mode as appropriate.  See section 2.1 "Operation modes” for details. 

Note that the prompt will provide useful information according to the current installation 
environment. 
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4.2 License 

In order to use LabSolutions Insight, an appropriate license must be installed.  The license is 
available in the form of an electronically authenticated software license or a USB dongle.   

One license is needed to run one instance of Insight.  That is to say, if 5 licenses are available and 
5 instances of Insights are running, an instance must be closed before another instance may be 
started.  Only one instance of Insight may run on a PC. 

LabSolutions Insight has the capability to search for licenses on a network.  Any license installed on 
the same subnet can be shared amongst installations of Insight.  However, only the local licenses 
can be viewed using the Application Configuration License Server Information window; licenses 
installed on other PCs on the network will not be listed. 

An exception to the license sharing capability is when Shared Insight is enabled.  When Shared 
Insight is enabled, licenses can be shared across subnets.  Please see 4.3 Shared Insight on 
details about Shared Insight. 

 

4.2.1 Using an Electronically Authenticated License 

When using this type of license, authentication over the internet is required.  Access the Shimadzu 
software license management system using a web browser and activate the software license. 

See the “Software License Authentication Manual” shipped with Insight for instructions on how to 
authenticate a Shimadzu license.  The instruction manual explains how to authenticate a 
LabSolutions license.  Replace “LabSolutions” with “LabSolutions Insight” and follow the same 
instructions. 

 

Hint 

It is recommended that the following folders are excluded from the anti-virus software 
scanning routine if any are installed: 

⚫ C:\ProgramData\Shimadzu 

⚫ C:\Program Files (x86)\Shimadzu 

⚫ C:\Program Files (x86)\MSOLicense 

⚫ C:\Users\(Windows Username)\AppData\Local\Temp 

⚫ C:\Users\(Windows Username)\AppData\Roaming\Shimadzu 

 

When LabSolutions LCMS is not installed, run "Software License Management Tool" described 
in Software Activation Procedure from the following location on the start menu. 
 
Windows 10 

Windows button→Shimadzu License Management Tool | Software License Management Tool 

 

Windows 11 
All Apps | Shimadzu License Management Tool | Software License Management Tool 
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The license becomes activated once the PC is rebooted after authenticating the license. 

4.2.2 Using a USB Dongle 

Insert the dongle on a PC after installing LabSolutions Insight.  Reboot the PC for the license to 
take effect.  If multiple dongles are inserted on a single PC, the licenses are added up. See section 
1.12 "Licensor Server Information” on how to view the number of licenses available on the system. 

4.3 Shared Insight 

When Shared Insight is enabled, one installation of Insight can be shared by multiple PCs that do 
not have Insight installed on them.  The PC on which Insight is installed is called the Server and the 
other PCs accessing this Server are called Clients.   

 

 

4.3.1 Setting up Shared Insight 

4.3.1.1 Server Setup 

First, install Insight on the Server PC.   

Create a new folder to be used as the shared folder.  This should be somewhere accessible by 
other users such as C:\LabSolutionsInsight\Shared. 

Please see Section “1.11Shared LabSolutions Insight browser” on how to set up the shared folder 
and network details.  

 

An existing Shimadzu Software License Management System account for authenticating 
LabSolutions products can be used to authenticate the Insight license. 

 

 

 

The same Shimadzu Software License Management System account for authenticating 
LabSolutions DB LCMS/CS can be used to authenticate the Insight license. 

 

 

 

There is no need to connect the PC with LabSolutions installed to the internet.  However, 
license authentication is easier if it is. 

 

 

  

 

There is no need to install Insight on Clients, however all PCs wishing to run Insight and 
handle GCMS data must have one of the forms of GCMSsolution installation described 
in Section 0. 
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After setting up Shared Insight on the Server using Application Configuration, share the Shared 
Insight folder over the network using the standard Windows operation.   

In Windows Explorer right click on the folder to be shared, select Properties and select the Sharing 
tab.  Press the Share… button.  Select who to share the folder within the File Sharing dialog and 
press Share. 

 

Please consult your site IT or Network manager for details as security policies differ from site to site. 

 

When LabSolutions LCMS or GCMS solution is installed on the server, LabSolutions user 
management database is also used by Insight. When LabSolutions LCMS or GCMS solution is not 
installed on the server, Insight uses its own user management database. 

Hint 

If the Server PC has more than one IP address, the Network Settings must be changed to 
specify which IP address should be used by Insight. Please see section 1.9 “Network 
Settings” for details. 

If all the licenses are to be managed on the Server, the Advanced settings for the Shared 
Browser setting should be changed to specify the license server from which the Clients 
should obtain the licenses.  Please see section 1.11 “Shared LabSolutions Insight browser” 
for details. 

  

 

For handling GCMS data, all user databases on the Server and Clients must be identical.  
Safe and correct behaviour of Insight is not guaranteed if user databases are changed on 
individual PCs. 
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4.3.1.2 Client Setup 

However, when printing reports of GCMSsolution and LabSolutions LCMS from Insight, installation 
of GCMSsolution and LabSolutions LCMS or its secondary usage license is required. 

On each of the Clients’ desktop, create a shortcut to SharedInsightLauncher.exe on the Server 
located in the path set up in Section “4.3.1Server Setup”.  For convenience, rename the icon to 
LabSolutions Insight.   

 

 

 

Set the Internet Option in the Client so that the Server is recognized as a secure site on the local 
intranet to avoid Insight invoking security warnings when it starts up.  Go to [Control Panel] -  
[Internet Options] then click on [Local Intranet] 

Hint 

Make sure to exclude the shared folder from the anti-virus software scanning routine. 

  

 

Make sure to make arrangements to allow the Client to access the Server through its firewall.  
Please consult your site IT manager for details as security policies differ from site to site. 

  

 

When allowing more users to access Insight set up for handling GCMS data, additional users 
must be added to the GCMSsolution user management database using the PC on which 
GCMSsolution can be activated (e.g. the Server PC).  Once new users are added, the user 
management database must be copied to all Client PCs again. 
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Click on Sites. 

 

Click on Advanced. 
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Add the location of the Server in the form file://<server location>. For example, file://test32. test32 is 
name of server pc. 

 

4.3.2 Using Shared Insight 

Double click on the LabSolutions Insight icon created following the steps in Section "4.3.1 Setting 
up Shared Insight” to start Insight.  Select OK for any security messages that appear. 

The Insight Launcher is displayed. 

  

 

Select the required version of Insight to proceed.  If a version of Insight is not available for use, e.g. 
because some software components are not installed, then the icon comes up greyed in the 
launcher. 

On starting up, Insight will ask whether to associate the DAMLP file type with Insight.  Select Yes to 
associate DAMLP files with Insight.  Otherwise, select No or Cancel.  Check the Never ask again 
check box to not show this message on starting Insight. 
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4.4 Uninstallation 

To uninstall LabSolutions Insight Software, select Start Menu > Control Panel > Uninstall a 
Program.  
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4.5 Program Alteration Check 

LabSolutions Insight Software incorporates a function to check that the program is installed 
correctly and the program is not altered after the installation. 

To open this program select Start Menu > All programs > LabSolutions Insight > Installation 
MD5 Check 

 

Selecting Check Program Files initiates the program check and the result is displayed. 
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Appendix A Export formats 

Appendix A: Export formats 

Output item list (Format: By View (Compound)) 

This format is used when [By View] is selected for the format option and [Compound View] 
is selected for the current display setting. The format for numbers is determined according 
to the Application Configuration settings.  

 

Output item list (Format: By View(Summary)) 

This format is used when [By View] is selected for the format option and Summary View is 
selected for the current display setting. The format for numbers is determined according to 
the Application Configuration settings. 

When the summary is displayed by samples vs compounds 

 Item Content Format 
Fixed (items always displayed regardless of display settings) 

Data Filename Data file name String 

Flags Flag status String 

Outliers 

Review 
 

Sample Name Sample name String 

Sample ID Sample ID String 

 (Compound name)  String 

 ＋items added to [Selected Columns] in options for Summary View 

 
 

When the summary is displayed by samples vs compounds 

 Item Content Format 
Fixed (items always displayed regardless of display settings) 

Item Content Format 
Header (Items displayed as the header of tables) 
ID # Compound ID Numeric 

Name Compound name String 

Fixed (items always displayed regardless of display settings) 

ID Row Number Numeric 

Flag Flag status String 

Outliers 

Review 
 

Flag ID Flag ID String 

Data Filename Data file name String 

Variable (items selected according to the table style settings) 

 ＋items added to [Selected Columns] in options for Compound View 
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Name Compound name String 

Flags Flag status String 

Outliers 

Review 
 

 (Sample information)  String 

 ＋items added to [Selected Columns] in options for Summary View 
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Output item list (Format: Fixed format (Compound vs. 
Sample) 

This format is used when [Fixed format (Compound vs Sample)] is selected for the format option. 
The format for numbers is determined according to the Application Configuration settings. 

 

 

Output item list (Format: Fixed format (Sample vs. 
Compound) 

This format is used when [Fixed format (Sample vs Compound)] is selected for the format option. 
The format for numbers is determined according to the Application Configuration settings. 
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Appendix B Definitions 

Appendix B: Definitions 

 LabSolutions Insight uses many data analysis parameters, and outputs many processing and 
evaluation results.  Many of these values are common to LabSolutions and/or GCMSsolution but some are 
unique to LabSolutions Insight.  The parameters and results and their definitions are listed below.  For 
further information, please refer to the User Guides for LabSolutions LCMS and or GCMSsolution, or their 
online manuals. 
 

Item Content 

Compound Information 
 

ID# Compound ID 
 

Name Compound name 
 

Type Displays the type of compound. 
 

  Reference   
 

  ISTD   
 

  Target   
 

  ISTD & Reference   
 

m/z Mass per charge 
 

Group # Displays the group number set in the compound table. 

 
Event Individual MS condition at analysis is "event", event number is displayed. 

Sample Information 
 

Sample ID Sample ID 
 

Data Filename Data file name 
 

Sample Name Sample name 
 

Sample Type Sample type 
 

    Unknown   
 

    Standard   
 

    Control   
 

    Unspiked   
 

    Spiked   
 

    water Note: 
 "water", "solvent" and "matrix" are user-
defined blanks that can be set in Application 
Configuration. 

 
    solvent 

 
    matrix 

 
Vial Vial number 

 
Tray Tray number 

 
Inj Vol Injection amount[μl] 
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Aqcuired Date Analysis date yyyy/mm/dd hh:mm:ss 

 
Aqcuired By Name of analyst 

Integration parameters 
 

Mode ID Data processing mode IDs. 
IDs and their meanings are as follows. 

 
    DISPLAYED ID MEANING 

 
    Auto Auto Integration/Identification 

 
    M Manual Integration 

 
    MI Manual Identification 

 
    MI R1 Manual intengration applied to Ref 1 

 
    

 

Same for Ref 2 to 5  
 

    NI No Identified peak 
 

    IR Outisde of reference ion ratio range. 
 

    ND(W/B) Outisde of Window/Band range. 
 

    BMSI Under minimum similarity index 
 

    NP No peak 
 

    +(S) Peak saturated 
 

    +<>R1 Switched with Ref 1 
 

    
 

Same for Ref 2 to 5. 
 

      Note: + indicates ID can appear on its own or 
in conjunction with other IDs, e.g. Auto (S) 

 
Mode Data processing modes corresponding to Mode ID above. 

 
Band Identification parameter.  

See User Guide 3.21 Edit Method for details. 
 

Slope Peak integration parameter. 
Method value is used when set to "Default".  
Can be set individually for GCMS. 

 
Width Peak integration parameter. 

Method value is used when set to "Default".  
Can be set individually for GCMS. 

 
Drift Peak integration parameter. 

Method value is used when set to "Default".  
Can be set individually for GCMS. 

 
Window/Band Identification method (Window or Band). 

Method value is used when set to "Default". 
Window or Band method is used when these values are set. 

 
  Default   

 
  Window   
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  Band   

 
Noise From Start time for noise calculation (minutes). 

 
Noise To End time for noise calculation (minutes). 

 
Noise Calc. Method Noise calculation method. 

 
    (LCMS) (GCMS) 

 
    ASTM ASTM 

 
    RMS RMS 

 
    EP Peak to Peak 

 
    USP   

 
    JP   

Calibration Curve 
 

Cal Point Select whether to include in the calibration curve. 
 

Level Calibration curve level.   
Calibration curve is built using concentrations set for each level. 
Refer to "Std Conc" below. 

 
Std. Conc. Concentration of standard or control sample for the specified level. 

 
Concentrations Concentrations of all levels. 

 
Calc.by Value by which to calculate concentrations (area or height). 

Method value is used when set to "Default". 
 

    Default   
 

    Area   
 

    Height   
 

Curve Curve type to fit to calibration points to create calibration curves. 

 
  Default   

 
  Linear   

 
  Point to Point   

 
  Quadratic   

 
  Cubic   

 
  Mean RF   

 
Zero Whether to force calibration curve through origin. 

Method value is used when set to "Default". 
 

  Default   
 

  Not Zero Forced   
 

  Zero Forced   
 

  Line to Level # 1   
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Weight Calibration curve weighting method.  

Method value is used when set to "Default". 
 

  Default   
 

  None   
 

  1/C^2   
 

  1/C   
 

  1/A^2   
 

  1/A   
 

1st Coeff. First coefficient of the calibration curve. 
 

2nd Coeff. Secondary coefficient of the calibration curve. 
 

3rd Coeff. Third coefficient of the calibration curve. 
 

Intersection Intersection of the calibration curve. 
 

Group Type Type of calibration when using Grouping. 
 

  Default   
 

  Group Calib.   
 

  Conc. Sum.   
 

RF  

 
 
 
When internal standard method is used:  

 
 

RF Mean (level) Mean RF 
Claculated when there are two or more "standard" type samples of the same 
level. 

 
RF SD (level) RF standard deviation. 

Calculated when there are two or more "Standard" type samples of the same 
level. 

 
RF %RSD (level) Relative standard deviation (%) of RF. 

Calculated when there are two or more "Standard" type samples of the same 
level. 

 RF Mean (curve) Average RF across entire calibration curve.  Calculated for “Standard” 
samples. 

 RF SD (curve) Standard deviation of RF across entire calibration curve.  Calculated for 
“Standard” samples.  
 

 RF %RSD (curve) Relative standard deviation of RF across entire calibration curve given in %. 
Calculated for “Standard” samples.  
 

Response Factor(RF)＝

Measured response (target)
Measured response (ISTD)

Concentration (target)
Concentration (ISTD)

 

Response Factor(RF)＝
Measured response

Concentration
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 RF RSE (curve) Relative Standard Error of the calibration curve. 
Calculated for “Standard” samples. 
 

𝑅𝑆𝐸 =  100 × √∑
[
𝑥𝑖

′ − 𝑥𝑖

𝑥𝑖
]

2

𝑛 − 𝑝

𝑛

𝑖=1

 

Note that RSE is not calculated for cubic or Manual RF curves. 
 RF Deviation 

 
 

R Correlation coefficient of calibration curve 
 

R2 The contribution rate of the calibration curve, the determination coefficient 
(which is the square of the correlation coefficient, used as an index of the 
effective figure of the concentration). 

Analysis Result 
 

Flags Two discrete types of flags. 
See User Guide 2.6.2 Flag types for details. 

 
  Outliers   

 
  Review   

 
Flag ID Flag identifiers. 

See User Guide2.6.3 Flag ID for details. 
 

Conc. (*) Conc. (unit) 
Concentration calculated from calibration curve. 

 
Unit Unit of concentration 

 
RT Set retention time. 

Please refer to user guide 3.15.2 Update RT/ Ion Ratio on how to update. 

 
Found RT Retention time (minutes) of the identified peak. 

If peaks are not identified, please check retention time and method 
identification parameters (Identification method, identification peak selection, 
spectrum Confirmation etc). 

 
RT Diff Difference (msec) between retention time of identified peak and set retention 

time. 
 

RT %Diff 

 
* Refer to RT and RT Diff for further information. 

 
Area Area of identified peak 

 
Height Height of identified peak 

 
Peak Start Start time (minutes) of identified peak 

 
Peak End End time (minutes) of identified peak 

 
Accuracy(%) The ratio (%) of the concentration calculated from the calibration curve to the 

concentration set in the standard sample 
Accuracy (%) = 100 - %Diff 

RF Deviation ＝
| RF Mean(level)  −  RF Mean(curve) |

RF Mean(curve)
 

RT Diff(%)＝
RT Diff

RT
×100 
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%Diff Diff(%) between set concentration and concentration calculated from 

calibration curve 
%Diff = 100 - Accuracy (%) 

 
%RSD 
(Conc) 

Percentage representation of concentration RSD (relative standard 
deviation).  
Calculated for each level when the sample type is standard or control and 
there are two or more samples of the same level. 

 
%RSD 
(Area) 

Percentage representation of concentration RSD (relative standard 
deviation).  
Calculated for each level when the sample type is standard or control and 
there are two or more samples of the same level. 

 
Noise Noise value calculated based on setting. 

 
S/N Ratio of identified peak intensity to noise value. 

 
Std RT Diff The difference between the average retention time of all the standard 

samples and the retention time of the identified peak. 
 

%Conc. Outside Curve When the calculated concentration is larger than the maximum calibration 
point (set maximum concentration) or smaller than the minimum calibration 
point (set minimum concentration), the value is calculated as follows. 
 

 
Note: It is not calculated for standard sample. 

 
Dil. Factor Coefficient to multiply set concentration by. 

Analysis Result(LCMS only) 
 

Width(50%) Full width at half maximum of the identified peak. 
 

Tailing F. 5% Tailing factor (Symmetry Factor). In the figure below, "W" is the peak 
width at 5% height, 
and "a" is the width of the first half of the peak (starting point to apex) at the 
5% peak height. Tailing factor is calculated as W/2a.  

 

 
Tailing F(10%) 10% Tailing factor. In the "Tailing F.", "W" is the peak width at 10% height, 

and "a" is the width of the first half of the peak (starting point to apex) at the 
10% peak height. 10% Tailing factor is calculated as W / 2a. 

%Conc. Outside Curve＝
Concentration -maximum or minimum point

maximum or minimum point
× 100 
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Asymmetry Indicator for peak symmetry. In the figure below, it is calculated as b/a.  

 

  

Analysis Result(GCMS only) 
 

SI Similarity with standard spectrum 

 
Ret. Index Set retention index. Retention index is an indicator of retention time of 

components using the retention time of the reference compound (n-alkane) 
peak. 

 
Actual Ret. Index The actually measured retention index. 

 
Sample Amt. Coefficient to multiply set concentration by. 

 
Data Comment Supplementary information can be added as required. 

Reference Ion 
 

Ref. Mode Referece ion mode used for identification. 
Method values are used when set to "Default". 

 
  (LCMS) (GCMS) 

 
  Default Default 

 
  Absolute Relative 

 
  Relative Absolute 

 
  Absolute or Relative   

 
  Simply Calculate   

 
Ref 1~5 m/z Mass to charge ratio of reference ions 1 to 5 

 
Ref 1~5 Set Ratio Displays the set reference ion ratio (intensity ratio of reference ions 1 to 5 to 

target ion intensity). 
For details, refer to the following contents of the user guide. 
3.15.2. Update RT / Ion Rations 
3.26.1. Update RT and Ion Ratios 
For more detailed setting method, refer to LabSolutions LCMS, 
GCMSsolution instruction manual or help. 

 
Ref 1~5 Range Range of ion ratio (%) in which target ions are identified.  Edit by chancing 

the Default Ion Allowance value in [Edit Method] [Identification] tab. 

 
Ref 1~5 Measured Measured reference ion (1-5) intensities. 
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Ref 1~5 Actual Ratio Reference ion ration calculated from measured intensities (reference ion 

intensity / target ion intensity). 

 
Ref 1~5 Std Ratio %Diff Difference ratio of ion ratio of each sample to the averaged standard sample 

ion ratios for each reference ion (Ref-n).* Averaged Std Ref-n = Average of 
Ref-n Actual Ratio of all standard samples 
 

 

 
Ref 1~5 Noise Noise value of reference ion 1 to 5 

 
Ref 1~5 S/N S/N of reference ion 1 to 5 

 
Ref 1~5 Conc. Reference ion concentrations 

 
Average Conc. Average of quantifier ion and reference ions (1-5). 

When reference ion concentrations are not calculated, quantitation ion 
concentration is given. 

 
Average Conc.(R1,R2) Average of quantifier ion and reference ions 1 and 2. 

When reference ion concentrations are not calculated, quantitation ion 
concentration is given. 

ISTD(Internal Standard Method) 
 

ISTD Name Compound name of ITSD 

 
ISTD Amount ISTD amount set in method 

 
ISTD Group ISTD group number set in method 

 
ISTD Area Area of internal standard compound 

 
ISTD Height Height of internal standard compound 

 
Area Ratio The ratio of identified peak's area to internal standard compound's area. 

 
Height Ratio The ratio of identified peak's height to internal standard compound's height. 

 
ISTD RT Retention time (actual measurement) of the identified ISTD compound peak 

 
ISTD RT Diff The difference between the retention time (actual measurement) of the ISTD 

compound and the retention time of the identified peak 

 
ISTD %Diff (Stds) Area Area ratio of ISTD to average of standard sample ISTDs. 

 
ISTD %Diff (Controls) Area Area ratio of ISTD to average of control sample ISTDs. 

 
Ref. RRT Reference relative retention time. 

 

 
 
* Refer to RT for information on "set RT". 

Ref 1~5 Std Ratio %Diff＝
| Averaged Std Ref-n-Ref-n Actual Ratio|

Averaged Std Ref-n
×100 

Ref. RRT＝
set RT

set ISTD RT 
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RRT Relative retention time. 

 

 
 
* Refer to Found RT and ISTD RT for further information.  

%Dev RRT Difference ratio between Ref. RRT and RRT.  
 

 

Recovery Test 
 

spiked Spiked amount 
 

Recovery Recovery rate obtained as a result of recovery test. In order to perform the 
recovery calculation, it is necessary to set the sample type to "Unspiked" or 
"Spiked" and set the spiked amount. 

Others 
 

Status Display the review status. 
See User Guide 3.29 Review for details. 

 
Custum Calc. Result 1~5 Display custom calculation results. 

 
Comment 1, 2 Supplementary information such as the compound characteristics can be 

entered as required. 

 

RRT＝
Found RT

ISTD RT 
 

%Dev RRT＝
RRT-Ref. RRT

Ref. RRT 
×100 
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